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D-View 5.1 User’s Guide

ABOUT THIS GUIDE

This User’s guide provides brief descriptions of how to use the various menus and operations
found in the D-View Network Management System. This guide does not discuss network design
or management concepts, nor does it provide detailed explanation or definitions of SNMP, MIBs,
RMON or associated concepts. It is assumed that the reader is familiar with these standardized
networking concepts and protocols; hence variables presented in the D-View menus are self-
explanatory. Variables such as MIB objects are listed exactly as they appear on the D-View GUI.

Overview of this User’s Guide

Chapter 1, “Introduction.” Lists system requirements, gives installation procedures. Shows you
how to get D-View 5.1 up and running.

Chapter 2, “New Features.” Explains D-View 5.1’s organization and highlights new features.

Chapter 3, “How to Manage a Network.” Describes how to manage a network with D-View 5.1.
Topics: Discover, How to Monitor and Manage a network, Using Telnet, Changing Device
Properties, Collect trap information to log file, Install Plug-in management module, Managing
SNMP Devices without a management module (MIB Compiler/Browser), Topology.

Chapter 4, “MIB Utilities.” Shows how to use D-View’s user-friendly dialogs to manage
without using plug-in modules. This chapter is organized according to the drop-down menu
items under “MIBs” on the D-View 5.1 GUL

Chapter 5, “Internet Tools.” Explains items in the “Tools” drop-down menu in the order of the
descending menu items.

Chapter 6, “Advanced Management.” Explains how to use trap management functionalities.

Appendix, “Troubleshooting.” Provides solutions to different troubleshooting scenarios.
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INTRODUCTION

This section gives systems requirements and explains installation procedures.

System Requirements

D-View 5.1 can be installed and operated on a computer that meets the following minimum requirements:
e CPU: 550 MHz
e DRAM: 256MB
e Hard Drive Available space: 100MB
o Ethernet Adapter: 10BASE-T
e Operating System: Windows 2000 or Windows XP
¢ Windows Component: Simple Network Management Protocol (SNMP)
e Access 2000

Installation

Note: 1o install D-View 5.1 you must use the Ethernet adapter provided with the software. If you
do not use the Ethernet adapter provided with the software installation will fail.

The following is a pictorial guide showing how to install D-View 5.1 and get it up and running:
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Step1l

Welcome to D-Link online

Figure 1-1.
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InstallShield Wizand

i D-4iewh. 1 Setup iz preparing the InstallShieldR ‘wizard, which
will guide pau through the rest of the setup proceszs. Pleaze wait,

..................................

Figure 1-2.
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Step 2

Installahield Wizamd

License Agreement

Please read the following licenze agreement carefully,

Prezz the PAGE DOWH key to zee the rest of the agreement,

ID-Link D-figws.1 i’

D-Link MO-MOMSEMSE LICEMSE STATEMEMNT
AHD LIMITED sWaARRAMTY

IMPFORTAMT - READ CAREFLILLY

Thiz licenze statement and limited warranty constitutes a legal agreement ["License
Agreement”] between you [either az an individual or a single entity] and D-Link, [he.

["D1-Link"] for the software product [*Softvare"] identified

above, including any software, media, and accompanying on-ine or printed ;I

Do you accept all the termsz of the preceding License Agreement? [F you choosze Mo, the
getup wil cloze, To inztall D-Afiewb T, pou must accept thiz agreement.

[FztalShield

< Back Tes MNa

Figure 2.
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Step 3

Installahield Wizard

Customer Information

Pleaze enter vour infarmation.

Fleaze enter your name, the name of the company for whom you worl, and the product
zerial number.

Uzer Mame:

Ben

Comparny Hame:

|DLink

Sernial Mumber:

[ztall5hield

< Back HiEwt = Cancel

Figure 3.
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Step 4

Inztallshield Wizand

Chooze Destination Location

Select folder where Setup will install files.

Setup will install D-Yiews. 1 in the following folder.

To inztall ta this falder, click Mest. To install ta a different falder, click Browse and select
anather folder.

— Desgtination Folder

C:%\Pragram FilezhD-Link Browse. . |

|metallShield

< Back

Cancel |

Figure 4.
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Step 5

InstallZhield Wizaod |

Setup Type
Select the Setup Type to inztall.

b

Click. the type of Setup wou prefer, then click Mest.

i* ;'L,.pi.gag Frogram will be ingtalled with the most common optiohz. Becommended for
................. £ oSt LSers.

 Compact FPrograrn will be installed with minirmum required options.

i Custom v'ou may chooze the optiohz you want to ingtall. Becommended for advanced
Lzers.

[metallsheld

< Back I Mest = I Cancel

Figure 5.

Typical : Installs D-View 5.1 , D-Link SNMP Solutions Modules, DES-3225G, DES-36241 , DES-
6000 , DGS-3208TG, DGS-3208F, DHS-3226, DHS-3218, DHS-3210, DES-3226, DHS-3224V,
DGS-3224TG, DHS-102, Wireless AP

Compact: Installs D-View 5.1 , D-Link SNMP Solutions
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Select Frogram Folder
Pleaze zelect a program folder.

Setup will add program icons to the Program Folder listed below. vou may type a news folder
name. or select one from the esisting folders list. Click Mest to continue.

Program Folders:

E =isting Folders:

Cadoliraw

Curnulus

D-Link

IhztallShield Profeszional 2000

InterB aze

Linkk anager

Latiis [ FH & R _I

Ficrozoft Developer Mebwork

Imztallshield

< Back I Mext = I Cancel I

Figure 6.
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Step 7

Install5hield Wizard Complete

Setup has finizhed installing D-Aiewh. 1 on your computer.

¢ Back

Eancel |

Figure 7.
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Before you are Running

Note:. if device can’t be found under discovery, then you must enable SNMP service in Windows
service before you run D-View 5.1, and remember to disable the SNMP trap service before you run
the D-View

S T=TEY

BaiZcERiE = HFFT:ET:'G@):l A -]

Windows TfF
OO LA B F 80 Windows 2000 TTiF =

NFrRmmEsiElirt SRR AN - KESRFT HEeRERS it -
MFERWATHAT ik FREEN]

TLHFC):

E Indexing Service
] g Internet Informatinn Services (15)
= 2t at and Monih als
[ =2 Message Quening Services

b{=Pu BEERE e EER TR -

e BB, 223 MB —
Bt o FIZERS: 200652 MB _SEERD.. |

08 ME

-

t—#@ | [FTHw-] = |

Figure 8-1.
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1o x|
| &t wmo ||« » | B@EFE0E (@] » = 0 = |

£E | [ 4hee | BEMER | E2Asn | |

8 008 REVP G Fah Localystem

%Remt& Access Auto .. BT F#h LocalSystem

88 Remote Access Conm... 337 & F&h LocalSrstem

%Remote Procedure C... 184 B5§h Bih Local3wstem

%Remote Procedure C... &3 Fih LocalZystem

%Remote Registor Ser.. JLEF.. B5dh Bih Localfystem

%Removable Storage =i X Bih LocalZystem

% RIP Listener = B =E) LocalSystem

%Routing and Remote . TR =H Local3ystem

%RUM’,S Service B5H ... E&h Hah Local3ystem

S Becurity Accomnts M. FATF..  EEh =E] LocalSrstem

S Berver 12 .. EEh SE] Localdystem

8 Bimple Mail Transpo... F54... =Ed)| Localystem

8 Bimple TCPAP Servi.. F1E.. B =L Localdystem

88 Smart Cavd g F&h LocalSystem

%Smﬂ.ﬂ Card Helper 1R Fih Local3wstem

S5 SNMP Service BE. EE =El

%System Event Notific . 3B .. & B

833 Task Scheduler iz B =E

2. TCPAP NetBIOS Hel . B5F3 .. &8 B3 LocalSystem ~|

| |

Figure 8-2.

12



D-View 5.1 User’s Guide

Step 1

Windows Tpdate

k %‘ ningtall D-¥iew5.1 & D-Link SNME ...

Internet Explorer
Cuflook Express

T4 03:57

Figure 9.
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Step 2

&% D-view 5.1 E B[] 5
Swstem  View Edit MIEs Tools &ccount  Window Help

ﬁ C a ﬁ E Toal |UserDefine|
MH ot (581 8 [ 197

Create a New Database x|

-— B

Create a New Database

Mo |

Meszages I Traps |

Figure 10.
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Step 3

Switen  View' Edif MIB: Tools Accound Window Help

A 1o mg| ™ usmoeim]
PR ] el T 1K

Messages | Traps |

Discovering device

Figure 11.

15
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NEw FEATURES

This chapter explains the organization and highlights new features of D-View 5.1.

Organization

D-View is organized into five main components

D-ViewS.1

Plug-in
Modules

Alarm/Trap Discover &

. MIB Utilities | Internet tools Accounts
Manager Parsing

Access Database

Figure 12.

16
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New Features

Some significant additions are new to this generation of D-View software:

e A number of powerful Layer 3 utilities including IP Forwarding, RIP 2, OSPF, IP MRoute,
DVMRP and PIM functions have been added to accommodate the increasing presence of
Layer 3 switches and advanced routers in enterprise networks.

e The DIAP proprietary administrative protocol used in D-Link SOHO broadband routers
has been added so you do not need any additional utility to administer these devices.

e An array of Accounts information functions has been added for client record maintenance.

e A topology creation program is an embedded function of D-View. This can be used to
create diagrams and schematics useful for network design and layout planning.

e SNMP V3 for major MIBs

MIB II, IF-MIB(RFC2233), Entity MIB(RFC2737),
Bridge 802.1D(RFC1493), RMON,802.1P(RFC2674), 802.1Q(RFC2674).

e Trap/Alarm netification by using e-mail

17
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e  Multiple views for platform:

After Auto Discover is complete you can view objects in the Ethernet domain by tree view.
At the same time you can have a list view display open. Additionally you can create a
topology domain in the same workspace to make network management more convenient.

5. =10 =i
Swstern Wiew Edit MIE: Tool: Acconnt Window Help
ﬁl cl ﬂlﬁl@l Tool I USElDeflnel
o2 — O Ty
=- %%ﬂt oL - o ] = = S
El- Ethernet
SHMP 400 500 -
B 10.0.0.0 saast ®
'__| ﬂ CompanyGroup -
- General 10.1.1.166 1010.27.28  10.11.22.202
G- (R (BU=12]
- HP DES OFE- D=
-l Microsoft ] 2500 2=
[H--mmaa M ovell
i M 1011.79.33 10.11.94.224 10132246
G- 2 Marconi [802.154] [B02.1x]
Elﬂ Favorite
EI&& Fanl oES: oES: DI-t162
% 10.1.1.195 e : =
10.10.91.120 10167931 1016.79.35 10.21.97.200
- 10.16.79.133
w E& Rz DI-1162 DES- DEZ-
=- Topology 2205 2212
=B Domaind = = =
e 10.132.24.5 (802 10.21.99 2652 1022456 1036101
10.21.99.252 X
----- 2101122202[80 | |* 5
<1 | =
Meszzages ITlaDS I
IFP: 10.36.56.86 iz connected  at_E4F 09:49:06 H
IP:10.20012.2 is connected  at_E4F 09:49:06
IP:10.11.22.202 is connected  at_E4F 09:49:06
IP:10.50.11.9 is connected  at_E4F 09:48:06
IP - 10.3R AR AR i dizmnnnected ab FS9F N3-47-3R LI

Figure 13.
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e Powerful MIB Compiler and Browser:

With an easy to use GUI, MIB Compiler and Browser can be used independent of D-View
or can be used with the D-View software. This makes network management more effective
and efficient.

8 D-Link MIE Compiler - [RFC1213-MIB] =10] x|
’ File Edit ¥iew Toolz Window Help — IE’ |5|
A EEE R EE S

Browsze Sgent [P I-I 0 . I-I . I-I . I-I BE Read Cormmunity IPUinC Wwrike Co

Ed - MIB Tree Cibject marm: s _oitac AI

Ll - =43, iso Obiect ID 13612
5+ BRIDGE-MIE L_—_Ia sustem Fodnle REZ1213

S EMTITY-MIE bl swsDescr

T AMAIT ppe-l 4 sps0ObjectD Baze symta Oitet Stei
S0 | F-MIE A =vsllpTime Composed syntax Displacist
T GMP-STD £ 8 susContact Access Read- Wri
T PERIDGE -k A spsMame Statns tMandator
T Q-BERIDGE- M spsLocation Value list 1:0.255
%' RFC1155-5k A sypsServices

T REC 212 I:—]a interffaces FParent node syrsteim

= RFCIZ13 M [~ ifhumber ETE G Hone

o =& ifT able Description The textx
{ZVRFC1215 2 i o

{51 GMMPYE-CE W - or this m

— g o iflndex o hoe 1o
5 SHMPY2-MI A iDescr

5 SMMPY2-5k  ifType

5 SMMPY2-TC g it

5 SHMPYw2-Th ™ iSpeed 7 -
4] " r 3 4 | 3

Figure 14. MIB Compiler
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B D-Link MIE B - [ERIDGE-MIE]

#® Eile Tiew Tools Window Help — =] x|
e | m| =] 2

Browse Agent [P I'I 0 .I'I .I'I .I'IBB Fread Commurity : |public rite: Cornrmurity © Iprivat-

ZRIMIE Tree
bl odule ien
=43, dotldBridge
dot1dBase
48 dotldBaseBridgedddress
A dot1dBazeMumPorts
4 dotldBaseType
dot1dB asePortT able
E1-¢5p daot1dB azePortEnty
dot1dB azePort
-4 dot1dBazePortiflndes ||
4 dot1dE azePortCincuit
-4 dotl1dBazePortDelapE =
48 dot1dB asePorthd tuE noe
=43 dotldStp
dot1dStpPratocolSpecification
dot1dStpPriority
dot1dStpTimeSinceT opologyCh
dot1dStpT opChanges
dotld5tpDezsignatedF oot
dot1dStpRootCost
dot1dStpRootPort
dot1dStphd antige
dotldStpHellaTime
dot1dStpHoldTime
dot1dStpFanwardDelay
dot]d5tpBridgetd antge

dot1dStpBridgeHeloTime -
| >

Figure 15. MIB Browser

anadadnanaaaa
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e User Account management:

Account is a simple account management system to keep track of the bills.

It has the following features:

1. Each client assigned an account with personal authorization IP Address

2. Different groups of clients can generate statements with different schedules
3. Detects abnormal usage for clients

4. Assigns custom taxes to service charges

5. Credit adjust function allow you to insert credit records manually and give
credit for wrong or misdialed work.

6. Late fee assessment function

7. Real-time reporting

21
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3

How TO MANAGE A NETWORK USING
D-VIEw 5.1

This chapter describes how to use the various menus and operations found in the D-View
Network Management System with different example scenarios.

Orientation

Using D-View

D-View uses the same conventions as other Windows-based programs in its GUIL. Left-click to
select a device or domain, left-click to carry out a function from the drop-down menu, and so on.
If you double-click on an SNMP device, this will launch the device-specific module if it is installed.
If it is not installed, you will be offered an opportunity to download the module from the D-Link
website.

The three display panels of the D-View Main Menu:

22
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Tree View

e 10102710
10.10.27.28
[P 10.11.22.202
T 10.11.79.33 ¢
10.16.1.166
10.16.79.126
10.16.79.31
= 10.16.79.35
= 10.16.79.63
1017.11.77
B 1020125
-t 1022456
----- D= 10.24.69.100

List View

g 10.36.221.6
e T0.37.11.78

----- E 104294126 T
4 3

Messages IT[apS |

=0l
REIE
DEZ- s
CRENCEE
=)
10102710 10102728 101122202 1011.79.33 10161166
[B02.1) [B02.1X) [B02.1]
DEZ- DEZ- DEZ- DES- SHMP
Jaae 3326 I326 E200
) — (— =
101679126 10167931 10767336 10167963 101711.77 —
DEES- DEZ- DEZ- DEE-
6200 2208 w| 3226 26241
=)
1020125 1022456 102463100 10362216 10371178
SHMP SHMFP DHE- SHMFP DHg-
210 Faae
==
104234126 10423442 104371028 10434534 1004473226
IR0 134 LI

Messages/Trap

—>

Tree View:

Figure 16.

Presents the entire network grouped into major domains extending from Root.

require frequent monitoring.

23

The major
domains for the default setup are Ethernet, CompanyGroup, Favorites and Topology. The
Favorites group is a vacant domain available as a convenient means of tracing devices that
It can contain any or all devices and can be arranged into sub-
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domains as needed. The Company group is divided into sub-domains according to the device
manufacturer. The “tree” in this panel or any domain can be expanded or contracted to view the
contents of any group.

List View:

Displays the contents of whatever group is highlighted in the tree view. Large icons are used by
default; however, you may choose to use small icons, a simple list or a list that includes device
details.

Traps/Messages:

Displays Trap and connect/disconnect messages.

Use the View drop-down menu to customize the display panels.

24
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Topology:

Right-click on Topology under Root in the Tree View display to launch new topology diagram. Use
the “Tool” pad and “User Define” pad to modify the topology.

gf* D-Yiew 5.1 - [ Topology of NewTopology] - |EI|5|
@ System Miew Edit [Es Tools Account Window Help - |ﬁ' |5|
Taal | Uszer Definel
T
=-£=, Root 0 100 200 300 1400 SO0 Te00  TeOD 'BOD ™00 00D MT00 M200 N300 M400 500 MEOD .
Ethernet
ComparnyGroup 100
Favarite f
Topology
f- Eg NewT opology 200
[ 300
[ 400
[ 500
[ &0
[700
[&00
o -
g | o
Messages I Traps |
IP:10.24.50.1 iz disconnected at T 05:30:26 -
IP:10.42.39.10 iz disconnected at F9F 05:30:26
IP:10.42.41.10 iz disconnected at F9F 05:30:26
IP:10.4252.1 iz disconnected at F9F 05:30:26
IP:10.4351.100  is disconnected at 9 05:30:25
IP:10.41.89.10 is disconnected at F4F 05:30:26
IP: 10.44.57.1 iz disconnected at F9F 05:30:26
IP:10.44.73.111  is disconnected at T4 05:30:25
IP:10.47.45.152  is disconnected at 9 05:30:25 =l

Figure 17.
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Smart Icons: The five main icons that appear in D-View 5.1 GUI are summarized below.

Ilcon

Description

B

Unknown device, device type and function not known.

RADIUS server.

i

Device off line or disconnected.

SHMF

SNMP device with SNMP agents.

Wireless Access Point

Table 1. General Device Icon Summary

26
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Basic Operations

Network Basic Information

The basic information available under System provides graphical and numerical information
about device type and role distribution. The information represents the sum total of the basic
information communicated by every device including non-SNMP devices. The graphical
representation can be viewed as a color-coded pie chart (default) or bar graph. Network make up
is broken down by type and role. Select your preference of graph style by clicking the graph icon
of choice in the middle of the menu. View network role or type distribution by selecting the
appropriate tab. The reference key explains the colors used for the graphs and displays the
number of devices in each category.

27
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System—>All Basic Information

£% all Basic Information =101 x|

Ethernet Domain 2
CompangiGroup Domain 7
Favorite Domain 1
Total Device 1A —
SMMP Device 118
Application Server 43

Sesgion Service 1 -
1 B

Device Typs Distribution Chart | Device Role Distribution Chart |

119 ShMP Device
52 General Device

Figure 18.

28
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Repolling Configuration

By default D-View polls the network for status updates every 30 seconds. This repolling
configuration can be changed or turned off using the Repolling Configuration menu under System.
Adjust the polling interval from 10 to 60 and the time out (1-10 seconds) and click the Set button
to put the settings into effect. Turn off repolling by checking the Don’t Repoll box and clicking Set.
Default repolling configuration = 30 sec Interval, 3 sec Time Out.

System->Repolling Configuration

£% Repolling Configuration

Interval [10.....60] {20 Sec
TimeOut(1.... 1003 Sec D efault

[~ Don't Repoling Clase

Figure 19.

29
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Community String Configuration

Set the Read and Write Community String to allow D-View management access to SNMP devices.

System->Community String Configuration
e Read Community String: input read community string
e Write Community String: input write community string

e OK: click to put settings into effect

£% Community String Config X

Read Cormmunity String Ipub“,:

Wfrike: Community S tring II:lri'-.fate A £
Cancel |

Figure 20.

Note: Read/Write Community String settings must be correct otherwise you will not be
able to find devices.

30
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Saving D-View Database

Save the current settings arrangement for D-View using the Save Database function located
under System. This will save any domains that have been created.

System->Save To Database

Clear Database

To delete the saved arrangements and settings, use the Clear Database function under system.

System->Clear Database

Note: Make sure that the database is one you wish to clear otherwise you will lose your
settings (Topology and Favorites).

Find Object

This option allows the user to quickly find a particular device in the system by entering Alias
Name, IP Address, or Module Name.
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Edit>Find Object

I Aliaz Marme ;I

=l
Start I
Cloze I

Search By

. 13
Input Sting AR Arees

kA adule MName

I *“whole veords only

N ame I IF Address I [ armain I Hole I
Find Objeck KI
Search By Elias Mame =

e 1) Start I
T “whole words anly Close I

I Domain I Role I

lnput String I

M ame I IFP Address

Figure 21.
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e Input Search By: select Alias Name, IP Address or Module Name

e Input String: enter Alias Name, IP Address or Module Name

Domain Control

Select a domain or sub-domain in D-View to add or create a new sub-domain. This can be done
under the Edit drop-down menu or right click on the selected domain to view the New Sub-
domain Form.

Edit->Domain

=1of =<
Vie Edit [MIE: Tools fAccount Window Help — 1= ><|
=il Dlewvice » | patine 1
= fin Hew SubDomeain
T R ey Mew Dewice
Find Ohisct Copyr
Ethermet Pacste
ComparuGroup Delete ba
17& General Rename
128 D-Link
£ HP
Bl ticrosoft
- mna Mowell
o1 B3 Marconi
B Favorite
+ b arconi
10.15.1.32
S Eme 10.16.79.133
EH Topologw
Mezsages I Traps |
IP: 101027 202 is comnected  at Fof O1:59:24 =S
IF:10.11.22.202 is connected  at T 01:52:54
IP:10.43.10.22 is disconnected at F<F 01:57:54
IP: 10041 441 is disconnected at FF 01:57:54
IF: 10.41.52.65 is disconnected at F<F 01:57:54
IP: 10.44.73.38 is disconnected at F=F 01:57:54
IP: 102529111 is disconnected at F<F 01:57:54
IF:10.36.11.55 is disconnected at F=F 01:57:54
IF : 10.36.56.586 is disconnected at F2F 01:57:54 il

Figure 22. Create a New Sub-Domain
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For example, the Company Group domain can be expanded using a list of companies. Select the
company you wish to add from the pull-down menu and click OK. Alternatively, you may select a
specific company group and create a new sub-domain within that group. Highlight the company
group from the main menu and pull up the New Sub-domain Form. A list of the devices within
that group appears listed in the left panel.

Select the devices you want in the new sub-domain and add them to the new group by clicking
the arrow

The selected device now appears in the Device List on the right side panel. Type in a name for the
new sub-domain and click OK to create it. Large Ethernet domains may be divided into smaller
work groups and are more easily managed using this function.

=10l

M e Drormain M ame I aCom ;I

Group M ame

II:u:-mpanyGrDup ﬁ | Device List
D-Link. = |

General
HF [elete
b arconi

Microzaft
et [ el

Cancel |

Figure 23.

34



D-View 5.1 User’s Guide

Edit->New Device

You may create a new device to be managed along with the other domains that already exist via
the New Device option. Enter the Device name, [P Address, Read /Write Community Strings,
Module Type, and check appropriate boxes in the MIB Database.

£% New Device i ]

D ewice lnformation

Device MHame: |1|:|_1_1_‘| IF Address: |1EI.'|_1_‘|

Read Caomm: IF"uI:IIic: “adrite Cormm: IF"rivate

Module Tupe: I DGS3205

MIB D atabaze

I BRIDGE-MIE [ EMTITY-MIE

T IAMAFTvpe-MIB [ IF-MIE

I~ IGHMP-5STD-MIE [ OSFPF-MIE

[ OSPF-TRAP-MIE I F-ERIDGE-MIE

T Q-BERIDGE-MIE I RFC1155-5kI ;I
(] I Cancel I |I

Figure 24.

Input Device Name: name of the device
IP Address: IP address of the device

Read Comm: Read Community string of device
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Write Comm: Write Community string of device
Module Type: Module type of new device

MIB Database: Check MIBs that comprise new device

Device Control

Edit>Device

Through the Device menu item under the Edit drop-down menu you may keep inventory and edit
the devices in your management database.

= E Em E S =
T 1SE LR L) -8 ) =1 FARLIES TE1L1IEd
s E S sy
nE NG o5 m B - £ B
ELEEEL] TEEEL:] TEEEL CEEEL] ERRE At EEEEEE 111157
B < < B B b =
TET 71 324 101104 723 IAIBI 13 IAFTI1E LR ] e AR WA IT G IR T IR IO INITIE
9 1ToE1T -
Eo=n =
T
11022
EF 11an1z
11 X
Trie=s
=
EF AR ;'

Figure 25.

Edit>Device>Properties allows you to control the settings of a particular device by entering
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e Device Name: Name of device usually in the form of numbers separated by periods.
e P Address: The IP address of the device.

e Read Comm: The Read Community String setting of the device.

e Write Comm: The Write Community String setting of the device.

e Module Type: The Module type of the device.

e MIB Database: Check boxes of MIBs of which device are comprised.

=101 >

—Device Informatior

Dewvice Mame:

IF Address: |1 01.1.1532

Read Comm: Ipubﬁc rasribe Comm: Il:lri'\.-'ate

MMaodule Type: IUhk.nchwn Tope I

— MIB Database

I BERIDGE-MHMIE I ENTITY-HIE

T 1AMRAFType-FIE I IF-HIBE

I IGHMP-STD-MIE I P-BERIDGE-MIB

I Q-ERIDGE-HIE I RFC1155-5k1

I RFC-1212 I RFC1213-mIB ;I
(] I Cancel I

Figure 26.

Press OK to execute property settings or Cancel to cancel.

Multiple View Settings in D-View

1. View->Topology View >50 %, 75%, 100% , 125% , 150% , Custom
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Allows you to have different views of the topology

£% D-¥iew 5.1 - [ Topology of NewTopology] oy =] 4|
(&3 System | view Edit [MIBs Tools Account  ‘Window Help &) =]
= |1 B
w Tree Wiew TS
| T Listview P e 100%
i = — —
< e Ul 125 %% T e e s v T S S TV NS L o L [V R T T =T S 1T s S
Backaground Caolor » 150%a T
----- {Dm| 1050955 g G
=] 10.50.96.2 Background Color
iy 1051141 erid
----- {D=| 10.51.2.10
B 10.9.68.101
10.9.6816 [~200
10.9.68.31
400
500
10.9.68.97 (80
----- 10.9.62.98 (80 [“eo0
&% 10.90.90.90
GG MewSubdoms ~00
CampanpGraup
Favarite
.. Topology 200
" B2y NewTopology —
| . =
<l I il | ]|

Messages | Traps |

IF:10.4473.33 iz connected  at B 11:39:42 i’
IP 101027 202 is disconnected at _E-F 11:33:12
IP 10486291 is connected  at _E4F 11:38:42
IP 1042 62 90 is connected  at _E4F 11:33:42
IF:10.44.73.33 iz disconnected at _E<F 112812

1P 10.10.27.202 iz connected  at _E4F 11:37:42

IP 1011 22202 is disconnected at _E“F 11:36:12
IP 10447333 is connected  at _ESF 11:35:12 _I
12 =

IF : 10.36.56.86 iz disconnected at_EF 11:35:

Figure 27.

View->Topology View->Background Color

Allows you to set background color of the topology

View->Topology View->Grid

Gives you the option of having a grid on the topology
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2. View=>Tree View

Allows you to see devices in the management network displayed in a tree on the left panel.
3. View->List View
Allows you to view devices in different ways: Icon, Small Icon, List, Report

4. View->Messages/Traps View

Allows you to view messages and traps on the bottom panel of the display screen

5. View—> Background Color

Allow you to set the background color for the Tree View, List View, Messages, and Traps
displays.
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£% D-View 5.1 - [ Topology of NewTopology] i ] |

@Systam View Edit MIEs Tools Accounmt Window Help _|ﬁl|1|
Al Topalogy Yiew ’ |rDefine|

v Tree View

| »
B v MessagesiTraps View

Backgroul r

L ———— - a
----- {D=| 10.50.95.5 List View
----- {De] 10.50.96.2 Messages

----- {ig 10.51.14.1 | Traps

..... g 10.968.16 [ 300
..... 10.9.58.34 400

------ == 10.9.62.80 o
----- % 109529 Bl
------ B 10.9.60.97 (80
----- 10.9.68.95 (30 [ E00
----- D] 10.90.30.90
[]----g@ MewSubdaomz
CompanyGroup
Farvorite

Topology

- Eé NewT opology

1 | _|: oI | _|J

Meszages | Traps I

IP: 10.90.90.90 iz disconnected at FF 11:43:42 3
IP:1010.27.202 s disconnected at L4 11:43:42
IP: 10.36.56.95 iz connected  at B 11:42:42
IF:10.18.96.12 izconnected st B 11:42:42
IP: 10121356 is connected  at_E 11:42:42
IP-101213.219  isconnected  at E9F 11:42:42
IP-10.10.27.30 is connected  at B 11:42:42
IP:10.12.13.56 iz dizconnected at_E4F 11:42:12
IP:101213.219 s disconnected at _E5F 11:4212 LI

[ 700

500

Figure 28.
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Starting off in D-View 5.1

When D-View is run the first time it will automatically search all around the net domain and
parse the contents in the network. It then creates a database to store the data and creates tree
lists, icon lists and the like in its work area.

Since this default search is just a rough search with quick response time it usually loses some
hosts. Hosts not discovered the first time could be found using the Discover functionality by
giving it a net domain and using unicast SNMP rule. You can search more thoroughly using
Discover but this search will be slower than the initial one.

Discover

Use this menu to search for a single device or several devices using the IP address or a selected
range of IP addresses.

In the Discover window define the following variables:

e IP Address Type in a range of IP addresses or a single IP address (in both
“From” and “To” spaces). Keep in mind that the time needed to do the search
increases as the range of addresses searched becomes larger.

e SNMP Read Type in the read community string.
e Time Out Range variable from 1000 to 10,000 milliseconds

e Search Approach Select Unicast (default) or Broadcast. A Broadcast request is
not IP address specific and will cause every device connected at the moment of
broadcast to reply.

e Discover Scheme Select SNMP or ICMP. ICMP will only report the IP address
of connected devices. SNMP discoveries reply with available device information.
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e Search Method Choose to find a single SNMP agent defined below by the
Enterprise ID or all agents in the previously refined search field.

Click on the Start button to begin the discover process. Unicast discovery will send Ping packets
to the selected range of IP addresses in ascending consecutive order and repost each reply as it is
received. Use the Save & Exit button to insert the device into the Tree View.

From |F Address | B _I: Iz-;.li S Search Approach ¢ Unicast & Broadcast |
TelRsddiess | 5es 255 [255 55 Dissover Schema (= SHMP ¢ [CHP |

SHMP Read Ipublic: —Search

= Alldaernts i SelectDewvice =t
TimeOut i Slg
s 1000 maec Enterprizel I —_—————
EEO, s A90R Sawve & Exit
T E =it

Mo, I |IF &ddiezz I Swztem D ezscription .

1 10.26.43.124 Unknown

2 1047 5410 Unkhnown

3 10.28.30.11 Atheros YWasforks SHEPYT AeZ2c Agent

4 10.47.53.201 Unknown =

5 10.29.79.108 Atheros Waiwforks SHEPY] Ae2e Agent

E 10266217 Unkhaown

K 10.228.30.10 Atheros YWasforks SHEPYT AeZ2c Agent

2 10,409,200 Hardware: =26 Family 15 Model 2 Stepping 4 AT AT CORM. ..

=] 10.42.43.11 Hardware: 86 Family & bModel 8 Stepping 6§ AT AT COMP...

10 10.44 73 222 Hardware: =86 Family 15 Model 1 Stepping 2 ATAAT COM. .

11 101027 67 Unkhnown

12 10.50.517.1 Hardware: =86 Family 6 MModel 11 Stepping 1 ATAAT COM.

13 10.9.18.700 U rknown )

14 1050821 Hardware: #8286 Family 15 Model 1 Stepping 2 ATAAT COM. .

4] |

Found Device | IP = 1044 671 at £ 10:27:46

Fournd Device | IP=104252 1 at _EF 10:27:45

Found Device | IP = 104782100 at _ 10:27:45

Found Device | IP = 10423310 at _E<F 10:27:45

Found Device | IF = 10,4294 42 at _FF 10:27:45

Found Device ! IP =10.50.8.23 at _E 10:27:45

Figure 29.
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How to Monitor and Manage a Network

D-View polls all devices automatically. If a device is disconnected, D-View will display a
disconnected icon in the work area. Otherwise, it will show a device icon.

The D-View platform allows users to set up special cases to monitor and manage and supports
multiple ways of doing so.

Scenario 1:

Monitoring Device 10.1.1.194 DES3225G (shows both connected status and disconnected status)

Connected
w 5 1 - [Li o A7 =101 >=|
T MIEs Tools Account Window Help — =1 =]
= & | =] T | user Define |
R FSE=1 =i | 1
3 7 o ==

=]
10.1.1.194

= fi Domains,

e F 101 1.1 1594
----- B Topoloaw
| 1 3

tdessages |T,E,:.S 1

Figure 30.

Disconnected (When device does not respond during Repelling)
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: =10 x|
[E) Swstern  Wiew Edit RIB: Tools Account Window Help = |
ﬂ c Blﬁl@l Tool I User Diefine |
noE
LEE =) ﬂ [ | A T [
: {3-1 10,4862 91 [¢
D= 10.40.72.91 [t )
B=] 10.49.66.1
= 10.9.68.101
8= 10.9.68.31
B=] 10.9.68.80
B=] 10.9.68.91
8= 10.9.68.97 (80
B=] 10.90.90.90
£E HF
Wl Microsoft
Bl [ owvell
E® tarconi
a Favorite
P 10.1.1.194
@ Topolog_p
< | >
Meszages I Traps |
Fepoling : IP = 10.20.90.90 iz dizconnected at F - 03:10:58 AI
Repoling : IP = 10.9.62.97 iz disconnected at FF 0Z10:52
Repoling - IP = 10.3.68.91 iz disconnected at F<F 0Z:10:52
Repolling : IF 10.9.68.80 iz disconnected at F <= 03:10:57
Repolling : IF 10.9.68. iz dizsconnected at FF 0210:57
Fiepoling: IP = 10.9.65.101 s disconnected at F=F 031057
Fepoling: IP = 10.49.66.1 is disconnected at F<F 03:10:57
Fepoling: IP = 10.48.72.91 iz dizconnected at F<F 021057
Fepaling: IP = 10.48.62.91 is disconnected at F-F 02 |

Figure 31.
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Scenario 2: Managing device 10.1.1.194

Using “Web Configure”

Step 1: Right click on mouse to execute “Web Configure”

I w4

(B Svstern Wiew Edit MIBs Tools Account Window Help — =) =]

|

Taol I User Define |

| 10.4862.91 [¢
D= 10.42.72.91 ¢
D= 10.49.66.1

1.1 1
Bl

Mol

g tarconi

=

= ﬂ F avorite

=l E& Domalnﬁ.

Messages ITfaDS I

DES
seesa
Basic Information
Properties
Copy
Delete
Repolling

MIE Tools

Find Devicel IP=101.1.

Discover : 10.1.1.194 at 9 03:11: 53
Fiepolling : IP =
FRepolling : IP =
Fiepolling : IP =

Fiepolling : IP =
FRepolling : IF =

0.90 is disconnected at FoF 03:10:58
97 iz disconnected at T 03:10:58
9 iz disconnected at T<F 03:10:558

3 s disconnected at FF 031057
101 is disconnected at F-F 0310:57

10,909
10.9.68.
10.9.68.
Repaoling : IF = 10.9.68.80 iz disconnected at FF 02:10:57
10.9.68.
10.9.68.
10.49.E

Repolling : IF =

£.1 iz disconnected at F < 03:10:57 =l

Figure 32.
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Step 2:

23 hittp:#10.1.1.194 - Mic

ft [nternet Explorer

=101 ]
| BEE REE WRO ZHSTFQ IAD HEE

| #-E - =» - @2 4| Qus GnneE @us |D-S=H-HO
|85 @Hotr »| | #4ED) |&] hip10.1.1.194

~| pBE

DES+3225G

l_ ’_|° Lnternet

Figure 33.
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Using the “D-View Module”

Double-click on the device Icon or right-click on “D-View Module” to execute:

@ Svstern View Edit MIBs Tools Account Window Help

ﬂl*lﬁ Taal ILIserDeflneI

=10l
=181

& e
— || |||

[ e 0sezIn(al| oe
- [Dm| 10.48.62.91 [5 e ]
[P 10.48.72.91 (¢ il Bssic Information
~{D| 10.49.66.1 _
[P 10.9.68.101 Properties
[P 10.9.68.31 Capy
--[DE] 10.9.68.80 Delets
[P 10.9.68.91 ;
(D= 10.9.68.97 (30 Eepolling

.. D] 10.90.90.90 MIE Taols >
HP
Microsoft
Movell

Favonte
Bl E& Domalnh

-2l
----- @ Topolog_l,l

< | 3

Messages IT[apS |

Find Devicel IF =10.1.1.194 at 4 03:11:63

Dizcover : 10.1.1.194 at F<F 0311:53

Fepoling : IP = 100909090 iz disconnected at 9 0310:52
Repoling: IP = 10.9.68.97 is disconnected at F<F 03:10:52
Repaoling: IP = 10.9.68.91 is disconnected at F<F 02:10:52
Fepoling : IP = 1009.68.80 iz disconnected at T 03:10:57
Repoling: IP = 10.9.68.31 is disconnected at F<F 03:10:57
Fepoling: IP = 10968101 iz disconnected at T 031057
Repoling : IP = 10.49.66.1 is disconnected at 4 03:10:57

Figure 34.
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; i =13
() svstem View Edit MIBs Tools Account  Window Help == ]
ﬁ C Tool l Uzer Definel
non —

T RE=] &)= =] ET]

[D=] 10.43.62.90 [{ = DES_

D= 10426291 ¢

-] 10.48.72.91 [t 10.1.1.194

il 10 A9 EEd

=10

Configuration ¥LAN Monitor Resst
DES-3225G
Parer

Biot3 Gign

: Hevvwvvreeves

Uplink-2m  4n Bm 10m 13x 14n  16x 18x 20w 23w

[

|Get Ok! Reguest:Led Status Received at 03:19:09 7F F,

Eix B

Xy 10.1.1.194
4] : | 3|

Messages IT,aps |
Find Devicel IF =10.1.1.134 at T 0311:53 3

Discover: 10.1.1.194 at "F<F 03:11:53

Repoling: IP = 10.90.90.90 iz disconnected at F=F 03:10:58

Repoling: IP = 10.9.62.97 iz dizconnected at F2F 03:10:58

Fepoling: IP = 10.9.68.91 is disconnected at F< 0X10:58

Repoling: IP = 10.9.62.20 iz dizconnected at F- 0210657

Repoling: IP = 10.9.62.31 iz dizconnected at F2F 03:10:67

Repoling : IP = 10968101 is disconnected at F<F 03:10:57

Repolling : IP = 10.49.66.1 is disconnected at "F<F 0310:57 [=

Figure 35.
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Using Telnet

Right-click on mouse to execute telnet.

4]

Tools  Account

MIB=
Taol I User Define |

Window Help

_ioi x|
=1

3 HP
Bl Microzoft

4

tessages I Traps I

Bssic Information
D= 10.48.72.91 It 701
[P 10.49.86.1 B
- [P 10.9.68.101 Copy
[T 10.9.68.31 Delete
[P 10.9.68.80
-[D=] 10.968.91 Repolling
-[P=| 10.9.68.97 (8t MIE Tools
-[D=] 10.90.90.90

Web Confizure
T iew Module

Find Devicel IP =10.1.1.194 at F<F 0311:53
Discover: 10.1.1.194 at F4 03:11:53

Repoling : IP = 10.90.90.90 iz disconnected at F<F 03:10:58
Repalling : IF = 10.9.68.97 iz disconnected at T 03:10:58
Fepaling: IP = 10.9.68.91 iz dizconnected at F9F 03:10:52
Fepaling : IP = 10.9.68.80 is disconnected at 9 0310:57
Fepaling : IP = 1009.68.31 iz disconnected at F9F 03:10:67
Fepaling : IP = 10.9.68.101 is disconnected at T 031057
Repoling : IP = 10.49.66.1 is disconnected at F9 03:10:57

Figure 36.
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Step 2

DE5-3225G Fast Ethernet Switch Console Management
Copyright(C» 1999-2888 D-Link Corporation

Usernane: [N
1

Password: [

DISCONNECTION

Message Area:
Enter case—sensitive username.

THL+R = Refresh

Figure 37.
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Changing device properties

When you need to modify an IP address for a device use the “Properties” menu item on the device
pop-up menu to change its identity.

Scenario 1: Changing the device 10.1.1.194 from DES-3225G to DES-3226

Step1: Right-click with mouse on “Properties”

. - _ioi x|
@ Swstern Wiew Edit MIBs Tools: Account Window Help =1a] =
ﬂ c ﬂ Li Tool I Uszer Define I
nislanm o=

{P=] 10.48.62.90 [f -~ DESE
=] 10,45 62.91 (¢
= 10.48.72.91 (¢ Bazic Information
D= 10.49.66.1 —
{P= 10.9.68.101
D= 1036831 e
D= 1096880 Delete
= 10.9.62.91 = =
{P=| 10.9.68.97 (B0 Repolling
‘[P 10.90.90.90 MIE Tools L4
G- HP Eink »
= -@l Microsaft
[F]-mwaa M oaowell
L]---g b arconi
g& Fawvarite
B && Domains,
Sk
=
EX _l_I
M eszages I Traps I
Find Devicel IP =10.1.1.194 at F<F 03:11:563 il
Discower: 10.1.1.194 at F4F 0311:53
Repoling : IP = 10909090 i= discornected at F<F 03:10:52
Fepoling : IP = 10.9.628.97 iz dizconnected at F<F 03:10:52
Repoling : IP = 10.9.68.91 is dizconnected at F=F 03:10:52
Fepoling : IP = 10.9.68.80 is disconnected at F<F 03:10:57
Repoling : IP = 10.9.68.31 is dizconnected at F=F 03:10:57
Fepoling : IP = 10.9.62.101 is disconnected at F < 03:10:57
Repclling : [P = 10.49.66.1 is disconnected at F<F 02:10:57 =

Figure 38.
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Step2: Press the “Type” Button

=lo]x]
ETE

@S_vstem View Edit MIBz Tools Accownt Window  Help
Tool |L'lserDefine|

-lolx

m 10.48 2 i~ Device Information
ﬁ 10.49.6| Device Name: ARRBEL P Address; 10.1.7.194
- [Dm] 10.9.68

g ]gggg Rt ||:|uh|ic ‘Wiite Camm: |private

AP 10968 4o Type: |DE53225G 4“"38
-[0E| 109,68
{0 10.90.9 ~MIB Datahase
-0 HP -
-l Miciosaft [~ BRIDGE-MIE [~ ENTITY-MIB

[ -mwad Moyl

= Marconi [~ 1AHBIType-MIB [ IF-MIE
[—]ﬂ Fawarite
=B Domaind [~ IGMP-STD-MIE [~ OSPFMIE =

-

4| ' | [~ OSPF-TRAP-MIE I~ P-ERIDGE-MIB

Messages | Traps | [~ G-BRIDGEMIE [~ RFC1155SMI B

Find Device! P =101.1.154 3
Discover: 101.1.194 at T4 0k Cancel

Repolling : [P = 10.90.90.90
Repaling : IF = 109.68 97 EOeCOnmeEseT ar T 0 1006
Repoling: IP = 10.9.68.91 iz disconnected at T4 03:10:53
Repoling : IP = 10.9.62.80 is dizconnected at F4F 03:10:57
Repaling: IP = 109.68.31 iz disconnected at F2F 03:10:57
Repoling : IP = 10.9.62.107 iz disconnected at T 031057
Repaling: IP = 1049661 iz dizconnected at 4 03:10:57 j

Figure 39.
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Step3: Select D-Link and DES 3226. Then Press OK.

-loix]
=181

@S_.ystem View Edit MIB: Tools Account Wigdaw Help

ﬂ C H * ﬁl Tonl |UserDefine|

dodule Type = Dlﬂ j
Company: |D-Link
Ethernet
=
CompanyGiou | s 3r0m, & ACC e AlidT lesyn 2
Ger?eral AxonMetworks ﬂ Cayrman i Clizco
hLg CMC o Comet djDEC
@8 Microsoft L ""EG'I EE,-bLmk_ ﬂa;maln ||
E“ Novel [ |25 Emulex ﬁ ibranics 6 | ﬂ -
Ea M arconi -
[_]ﬂ Esiitiiita Device Module: |DE5322E
EI&& Domaind
oz IR | | Modhule [ o a]
""" [H Topology - 1361471771.10.36.1.11
;EDE‘33224F| 13E61.41171.10362 =
Messages |Tra|3S | 2= DES3224D 13614117110363
l.'f"'|:!‘;:‘~"-'|'|DE| 1.361.41171.10371 hd
il | »
(1] I Cancel |

Figure 40.
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Step 4: Properties have been changed.

y Fory Ain] -IDIE[
EB System Wiew Edit MIE: Tools Account Window Help o =l |

E Toal |UserDefine|
= o)z @]

DES-
3206
Ethiernet =
CompanyGroup 10.1.1.194

- General
D-Link
4 HP

Bl Microsoft
[ mwaa e
a Marconi

[—]ﬂ Faw
SR

Messages | Traps |

Figure 41.
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Collect trap information to log file

The user can log the trap history. The trap filename and path is

/DLINK_INSTALL_PATH /var/log/trap.log. The user can clear it by using any editor to view and
clear it.

Log On Trap:

System->Trap Management->Log—>Log On

_ : B =] 5
Eﬁ Swstern Wiew Edit MIBs Tool: Account Window Help = |5’ |i|
ﬁ Drizcover |ser Define I

== A1 Bazic Information
|.

—— Eepolling Configuration

Community String Configure %| O bess DSa_as O oo D-;v DESsos O
Zawve To Database 101,112 10111686 1011194 1011.94224 10132246 1001679126 101
Clear Database
Trep M n Trap Editor M E 2o | E_
— Clear f— ] =
i Sort By » 10.24.37.200  10.37.11.78  10.41.5265 10.4
Trap Twpe Properties — o
Trap View Filter Setting . 3524 y
4 3
Messages Traps I Trap Mail SM TP Setting :
Time I Feceiv Trap Mail Betting B oo o — |
P 2002-07-08 09:36:34 1921681001 Enterprize Specific [4] Uptime: :31:00; .iz0.3.6.1.4.1.4101.3.1.00.0.0.0.0.0....
? 2002-07-08 09:36:34 1921681001 Enterprize Specific [5] Uptime: :31:00; .iz0.3.6.1.4.1.4101 . 31.00.0.0.0.0.0. ..

Figure 42.
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Log Off Trap:

System->Trap Management->Log—->Log Off

511 D-View 5.1 - m-D-Link] i |E|Ii|
Eﬁ Systen Wiew Edit MIBs Tools Account Window Help = |E’|i|
ﬁ Discover zer Define I
= All Basic Information
[ |z | €]
== Eepolling Configuration
Community String Configie M| D e Doy P 0 o Do A
e — == == —= i@
gave To Database 01112 1001166 1000094 1011.94224 10132246 101679126 101
Clear Diatabaz
Trap Editar e R w‘ E_
= Clear = == :
S Sort By v 102437200 10371178 10415265 104
Trap Tupe Pmperl:i.es DI o
Trap View Filter Setting Eriils ¢
1| »
Messsges Traps | Trap Mail SMTP Setting :
. . Wiew Log
Time | Recei,  L1rap Mail Setting W—I |
? 2002-07-03 09:36: 34 192.168.1001 Enterprize Specific [4] Uptime: 0:37:00; e0.3.6.1.4.1.4101.31.0.0.0.0.00.0...
? 2002-07-03 05:36:34 1921631001 Enterprize Specific [3] Uptime: 0:37:00; je0.3.6.1.4.1.4101.31.0.0.0.0.00.0...

Figure 43.
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View Trap and Edit:

System->Trap Management->Log->View Log

Discover
Al Bagic Information

ser Define I

=10l x|
=@ ]

Repolling Configuration
Comrmnity String Configure

}| T |I|5"?|

ES-
% % @ 008 SHMP

save To Databaze
Clear Diatabaze

10.0.0.1 101.1.12 10.1.1.151 101.1.152 10.1.1.153

Trap Management

Exit

10.1.1.161
10.1.1.164

-8 101.1.166

% 1011171 -
4| | >

Trep Editor ﬁ DES
Clear ==
Sort By v | 1011164 1011166 1011168

Trap Tvpe Properties

Tiap ¥iew Filter Setting ﬁ

Trap Madl SMTP Sething
Trap Mail Setting

Meszages I Traps |

N
10.1.1.155

15

10.1.1.169

=

10.1.1.177

=

LI

Figure 44.
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LA =10l |

WEE REE BA0 A

2001-05-08 17:17:42 (via .is50.3.6.1.4.1.3.1.1 =
Enterprise Specific Trap (8) Uptime: & days, 8:38:46

2801-85-88 17:17:43 (via .is0.3.6.1.4.1.3.1.1
Enterprise Specific Trap (@) Uptime: 8 days, 8:38:47

2001-85-88 17:17:44 (via .is50.3.6.1.4.1.3.1.1
Enterprise Specific Trap (@) Uptime: 8 days, 8:38:48

2801-85-88 17:17:52 .is0.3.6.1.4.1.171.198.8.1
Enterprise Specific Trap (3) Uptime: 1 day, 4:15:83
2i50.3.6.1.48.1.171.11.8.2.1.1.1.1.18 = 1 -i50.3.6.1.4.1.171.11.8.2.1.1.2.1.18 = 18

2001-085-088 17:17:52 .is0.3.6.1.4.1.171.198.8.1

Enterprise Specific Trap (4) Uptime: 1 day, 4:15:83
-150.3.6.1.4.1.171.11.8.2.1.1.1.8.8 = 1 .is50.3.6.1.4%.1.171.11.8.2.1.1.2.68.8 = 18 -is0.d

4| | H

Figure 45.

Note: For more on trap management functions please refer to Chapter 6: Advanced Management.
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Install Plug-in management module

If you need more management modules for devices, install the plug-in management module. You
can get modules from http://www.dlink.com.tw where all D-View supported modules can be
found. You can download all of these modules. When the module has been installed, double-
click on your chosen icon and a device panel will appear. To date D-View supports many kinds of
D-Link SNMP products. You are welcome to visit the D-Link web page for more information.

Scenario: Installing Plug-in DES3326 Device Module

Step 1

[ DES3326 Setup is preparing the InstallShield(r]
YWizard which will guide vou through the rest of
= the zetup procesz.. Pleaze wait,

100 25

Figure 46.
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Step 2

Welzome to the DES3E26 Setup program. T his progran will
inztall DES 3326 on your computer.

[t i strongly recommended that vou edt all \windows programs
before running this Setup program:

Click Cancel to quit Setup and then close any programs pou have
running. Click Mext to continue with the Setup program.

WARMING: Thiz program is protected by copyright law and
international treaties,

Unauthorized reproduction or diztribution of this program, or any
portion of i, man result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent poszsible under law.

[Rstal&hield

« Back

Cancel |

Figure 47.
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Step 3

Ter Information

Type pour name below, You must alzo wpe the name of the
company you work for,

M arne: Ben

Compar: IDLink

IRstallEhield

< Back Mest > Cancel

Figure 48.
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Step 4

Choose Destnation Location 5 .ﬂ

Setup will inztall DES3326 in the following directon,
Toinstall to thiz directany, click Hest.

Toinstall ko a ditferent directom, click Browse and select anather
directony.

“ou can chooze not to install DES 3226 by clicking Cancel to exit
Setup.

Destination Directony
|VIZ:'\...hD-LINKHD-‘-Iiew'\Mndules'\DES3325 Browse. .. |
Irstall5hield
¢ Back Cancel

Figure 49.
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Step 5

select Program Folder

Setup will add program icons to the Program Folder listed below,
'ou may type a new folder name, or select one from the existing

Folderz list. Click Mest to continue,

Fragram Faolders:

E sisting Falders:;

Cadoliram

Cumuiluz

D-Link

InztallShield Frofessional 2000
InterE aze

Linkh anager

Lotus FEF S,

£

[rztallShield

< Back Hest =

Cancel |

Figure 50.
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Setup has enough information to start copying the program files.
If pou want to review or change any settings, click Back. |f you
are zatizfied with the settings, click Hest to begin copying files.

Current Settings:

Setup Tope: :I
Complete:

Target Folder
C:APragram FilessD-LINEAD MigwhbModuleshDES 3326

Izer Information
Mame; Ben
Compary: DLink

4 of
Cancel |

IRstallEhield

< Back

Figure 51.
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Step 7

metip Complete
Setup haz finizhed installing the application on pour computer.

You may launch the application by selecting the icons installed.

Chick Fimzh to complete Setup.

IRstallEhield

. Back

Figure 52.
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Managing SNMP Devices without a management module

MIB Browser

When you need to manage a SNMP device without a plug-in module in the D-View platform use a
D-View supported MIB browser with the associated MIBs. Right-click on the chosen icon and you
will see a “Properties” item on the pop-up menu. Click it and a dialog box will appear with an
area listing many MIBs with checkboxes. Select which MIBs the device supports. Then click OK.
Go back to the work area, right-click on the icon again. Select “MIB browser.” This will invoke
the MIB browser with the MIBs that you selected. Now you can use the MIB browser to manage
devices.

Note: Before using MIB browser, you have to retrieve MIB files from a vendor who develops SNMP
devices. You can then use the MIB compiler to compile MIBs. If compilation is successful, then the
MIB compiler will store MIBs to database, and you will see the entire MIBs list under device
properties.
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How to Use MIB Browser

Step 1: Choose the device you wish to browse, right-click to bring up a menu and left-click on
“Properties”

IOl x|
T

@Sﬂstem Wiew Edit MIBr Took fAccount Window Help

Toal | Liser Define I

— o] v [

S SHMFP DEE - DEZ- OFE - THS - DEE- DES- &
[T F2ENG 225G 2600 224N 226 T2 Gl
& 101112 % —a | = -—
------ =] 10.1.1.166 101112 §fif EBestlnfommation  hpqigaoo4 10132246 101679126 10167
------ oz 101.1.194 —
""" ;;"? e DES- Cf T DES- DGs - DES- SHM
------ Bx 10.132.248 2205 il 3624 20z 3326 é_
...... e 101679126 = & Delete =, = ==’
------ s 1()16,79.128 1022456 100 . 10371178 10415265 104279108 10429
= n1e7as (a0 Eepoling
""" st MIE Tools C
""" % 1022458 SHMF 0E E_ o oo DG-104 DG-104 SHM
------ oy 10.24.228 8L i — = o
------ T 10,24.37.200 Car
______ - ol 10429465 104473240 10447338 1047.65105 10.48.22133 10482253 10484
T 10.37.11.78 1B 17 inns 17
4] SERIET | >

Messages |Tra|:|s |

Figure 53.
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Step 2: Enter settings and press OK.

f’i Dievice Properhes Form - |0O] x|

—Levice Infarmatian

Device Mame: 011 166 IP &ddress; (10.1.1.766

Fead Comm:  {public wiite Comm: oy ate

Module Type: |DES32256G Tvpe |

MIB D atabasze

¥ BRIDGE-MIB ™ ENTITY-MIB =
[ ISNAIT ype-MIB ™ IF-MiB

[~ IGMP-STD-MIB [ P-BRIDGE-MIE I
[~ O-BRIDGE-MIB ™ RFC11E5:SM

I~ RFC1212 " RFC1213MiE hd

QE | Cancel |

Figure 54.
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Step 3:

Open “MIB Browser”

1

) (=]
Swgten  Wiew Edit MIB: Tools Account Window Help = |
Toal | User Define I
— o]z @]
- SHMFP DEZ- DES- OFE - DES- DES- &
% 32250 32esG 2600 " 3zee T2
i & i | - &=
""" g AL i 101132 101 011.34224 10132246 10167126 100167
------ e 10.1.1.194 Properties
""" ;-? g DES- oe:  Copy ES- DGE- DES- SHM
------ == 10132246 z205 1 Delets 3624 3208 526
----- [De] 10.16.79.126 = & - = ==’
----- D= 10.16.79.128 022456 102 Repolline 0.37.11.78 10415265 104279108 10.42.9
------ o 10167936 e MIE Tools ”
...... % 1333;22[8[ SHMP OE Exeoute MIE Compilsr " D -104 SHM
...... o 10.24.22, -
______ i - ay ay & &
104294658 104473240 10447338 104765105 104822133 104832253
197 15

LoEm 10371178 7
| B <]

10484 _
2
| » I

Messages |Tra|:|s |

IP:
IP:
IP:
IP:
IP:
IP:
IP:
IP:
P

10.36.56.86 iz disconnected at F - 01:46:58
10447338 is dizconnected at FoF 01:46:30
104273108 iz disconnected at T4 01:46:30
102832111 iz disconnected at 5 01:46:30
104144123 is disconnected at F 2 01:46:30
10.41.52 65 iz dizconnected at 9 01:46:30
10.41.89.10 iz disconnected at 7 01:46:30
10.49.21.90 iz disconnected at F - 01:46:30
1060513 iz disconnected at F - 01:46:30

-

Figure 55.

69




D-View 5.1 User’s Guide

e o-uncrmromser 1=

File Wiew Tools ‘Window Help

el =S

Erowsze Agent P |1 0 .I'I .I'I .I'I E6 Fead Community ; IDUb“C Wiike Community ID'i‘\’atB

|

Module

Figure 56.
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Step 4: Double-click on RFC1213-MIB

Bz D-Link MIB Browser - [RFC1213-MIB]

A spsDescr
4 speObjectiD
& sp:UpTime
sysContact
o spshame
A zpslocation
o spsServices
= a interfaces
et iiMumber
=B iTable
=& iEntry
o iflndex
& iiDescr
& iType
o ikt
o ifSpeed
o iPhystddiess
& ithdrminStatus
o ifOperStatus
& ifLastChange
o ifinQOctetz
& iflnJcastPkls
& iflnMUcastPkis
& iflnDiscards
& iflnErrors

Figure 57.
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Step 5: Use MIB Browser to manage these entities

Bz D-Link MIB Browser - [RFC1213-MIB]

=-E iiTable

E1-&P iEntry
4 ifindex
o iDescr

& iPhysdddress
A ifAdminStatus
4 ifOperStatus
4 ifLastChange
& iflnDctets

& iflnlcastPkls
4 ifinNUcastPkts
& ifinDiscards
4 ifinErrars

Figure 58.
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&/ Browse Result Mode : system

Figure 59.

MIB Compiler

The MIB Compiler provides another way to manage SNMP devices without a management module.
It compiles an original Management Information Base (MIB) textual file into a system recognized
format and loads it into a database. It converts a MIB into a graphic tree view. A node of the tree
represents an object in the MIB. The relationship between nodes of the tree reflects OIDs of
corresponding objects in the MIB.
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The compiler shows detailed definitions of each object in the MIB:

Object name

OID

Module to which the object belongs
Syntax

Access limit

Status

Description, and so on.

The compiler can communicate with a remote device (bridge, switch, or router) to get the current
value or to set a new value for the MIB object of interest. This is achieved by sending SNMP
requests and receiving SNMP responses to get/set the value of the object of the MIB, which
resides in an SNMP enabled device.

Note: not every MIB is needed to be implemented in any SNMP enabled device

The current values of the MIB objects of a specific device can be obtained in two ways: “Info” or
“Table View.” “Info” shows more detailed information for objects, both definitions and values.
“Table view” shows only the values of objects.
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How to Use the MIB Complier:

Step 1: Invoke the MIB Compiler

D-Link MIB Compiler =10l |

File Edit %ew Tools Window Help

NEEEEEEEE

Browsze Agent [P I'I .ID . IEI . IIJ Fread Comrmunity : IPUb“C “frite Comrmumity @ Iprivate

|

MIEB

Figure 60.
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Step 2: Open up MIB File

Flle Edit Wiew Tools SWindow Help

MEEE

Browse sgent [P I-ID .I-I F
|

tIB

B pincris compler
o [ | 2

Look ir: | 3l MIB

x|« B3 ek B

K1

File name:  [RFC1213

TAMGIFType-MIB. mib

Z iz
8| RFC1215,MIB
[#]RFC1231,MIB
RFC1243, MG
RFC1253,MIB

] RFC1269, MIB
[#RFC1271,MIE
8| RFC1285, MIB
[#]RFC1304.MIB
[#|RFC1315.MIE
[#rFC1316. MIB

Open I

Files of ype: I *.mib

Figure 61.

Cancel |
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[ D-Link MIB Compiler - [C:}

Program Files',D-Link',D-Link SNMP Solutions',MIB\RFC1213.MIE]

@ File Edit Yiew Tools Window Help

=10l x|
o[-

e

AR E ]

MIB

Browsze Agent [P I'I o I‘I . I‘I 186 Read Community - IDUb“C Wirite Commurnity © Iplivale
|

RFC1213-MIB DEFIMITIONS &= BEGIMN

IMPORTS
mgmt, Networkaddress, Inaddress, Counter, Gauge,
TirmeTicks
FROM EFC1155-5MI
OBIECT-TYFE
FROM REFC-1212;

-- This MIB module uses the extended OBIECT-TYPE macro as
-- defined in [14];

-- MIB-II {same prefix as MIB-I)

mib-2 CBJECT IDENTIFIER = { mgmt 1}

-- textual corventions

DisplayString 1=

OCTET STRIMNG
-- This data type is used to model textual information taken

=Y R I At S U U NV I S NS

Figure 62.

77




D-View 5.1 User’s Guide

Step 3: Compile the MIB file

[ D-Link MIB Compiler - [C:*Program Files',D-Link’D-Link SNMP Solutions’,MIB'RFC1213.MIB] - |Elli|
) File Edit Wiew Tools Window Help 18] x|
& Open...  Chl+d | o | | @l
chri+S . I-I 188 Read Community : IDUbliC Wirite Community © Iprivale
Save As...
Prink... Chrl+P
i i RFC1213-MIB DEFINITIONS ::= BEGIN =

Delete MIE

L IMPORTS

Exit mgmt, Networkaddress, Ipaddress, Counter, Gauge,

TirmeTicks
FROM RFC1155-5MI
OBJECT-TWPE

FROM RFC-1212;

-- Thig MIB module uses the extended OBIECT-TYPE macro as

-- defined in [14];

- MIB-II {zame prefix as MIB-I)

mib-2 OBJECT IDEMTIFIER ::={ mgmt 1}

-- textual conventions

Figure 63.
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[ D-Link MIB Compiler - [RFC1213-MIB]

spstern
& syzDescr
& sp:z0bjectiD
& sy:zUpTime
& syzContact
o spzame
o sypslocation
o =spsServices
Ela interfaces
4 ifNumber
=B ifTable
E-&P iEniry
o ifindex
o i(Descr
o iType
o Mty
o ifSpeed
o ifPhystddress
o ifAdminStatus
o if0perStatus
o ifLaztChange
& iflnDctets

Figure 64.
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More on the MIB Compiler

1. How to find the MIB values of a device.

Step 1: Enter Device IP Address by entering the Browser Agent IP address, Read and
Write  Community settings. Then left-click on the MIB module you wish to view.

D-Link MIB Compiler - [RFC1213-MIB] =1al x|
’ Eile Edit Yiew Tools Window Help =181 x|

NEEEEEEERE
Browsze Agent 1P : I1D .I1 . I'I . I'IEE Fiead Commurity : IPUb"C Wik Comnunity : IP'i"’atE
|

=5 MIE Tres -\ A
MIB Ea is0
{1 BRIDGE-MIB El43 system
{ZENTITY-MIB & spsDescr
5 | ANATTupe-MIB & sysObjectiD
= FMIB & av:lpTime
5/ IGMP-STD-MIB & sysContact
(% P-ERIDGE-MIE & sysfame
{5 B-BRIDGE-MIB & syslocation
% RFCT155-5MI & sysServices
CTVRFC-122 B Gl |nter.faces
& itMurmber

51 RFC1213-MIB S T able
{T.RFCA1215 2 & fen
CTSNMPv2CONE O 0 T ® & findes
SiSMMPy2MIE B & iDescr
SiSMMPy2SME B & iTupe
{SSMMPv2TC o 0 & iMiu
(SiEMMPY2TM L & iiSpeed

----- & ifPhysdddress

----- & ifAdminStatus

----- & ifOperStatus

----- & ifLastChanage

----- & ifinOctets >
T & || I & iflnlcastPkis o [] KT _>_|_|

Figure 65.
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Step 2: Right-click on object and execute “Info.”

Figure 66.
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Left-click on “If Table.” Then left-click on “Table View” to display values.

Node : i Table

flose7etos

Set Table Add Entry

Figure 67.

2. How to set Device MIB values.

After completing 1. , left-click on “MIB Entry.” Execute “Set” or “Set Table” to set MIB
values. Or double click on “Entry.”

82



D-View 5.1 User’s Guide

o

]
{
]
{

|

{ [MULL] =

Set Cancel

Figure 68.

2 Add Table Entry

Figure 69
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3. How to edit the MIB Source file:

Double-click on a MIB Module bring up a tree-view.
“MIB Source” and proceed to edit the source file for the compiled MIB.

Under “View” left-click on

& D-Link MIB Compiler - [-BRIDGE-MIE]

=%l oBridgeMIB
=43, qBridgetIBObjects
Ea dot1gB aze
o dot]gvlanersionM umber
& dotlghdasvlanld
o dotlgMaxSupportedylans
o dotlgMumilans
oo dotlgGwipStatus
I:—]a dot1qTp
- dotigFdbT able
B¢ dot gFdbEntiy
‘ dat1gFdbld
dot1 gFdbDiynamicCount
=& det1qTpFdbTable
E-& dot1qT pFdbEntry
o dot1qT pFdbdddress
-4 dot1gT pFdbPort
“ff dotlgTpFdbStatus
- dot1qTpGraupT able
E-&p dot1qT pGroupEntry
-4 dot1gT pGroupdddress
- dot1gT pGroupE gressFPorts
-4 dot1gT pGroupleamnt
= dotlgFonwardAlIT able
dat1 qFansardallE nipy
dot1gFarmardAllParts

Figure 70
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D-Link MIB Compiler - [C:Program Files,D- -Link SNMP Solutions',SMIDB,RFC1213.MIB - | EI|L|
[@ Ele Edt view Iook Window Help =181 x|
AR E R EEE-
Browse Agent IP- |10 |1 1 188 Read Community - [public Wirite Community - |Private
E ﬂl RFC1213-MIB DEFINITIONS = BEGIN 3
‘=% BRIDGE-MIB
7 ENTITY-MIB MPORTS
{0 AMAIType-MIB mgmt, Networkaddress, Ipaddress, Counter, Gauge,
5 FMIE TirneTicks
5 IGMP-STD MIE FROM RFC1155-5MI
= bt o T e
- REC1155.5M1 FROM RFC-1212;
= RFC-1212
CTORFC1213-MIB -- This MIE module uses the extended OBJECT-TYPE macro as
5 RFC1215 -- defined in [14];
% SHMPw2-COMF
= GHMPw2-MIB
5 SHMPY2-5M|
o SMMPYRTE -- MIB-II (same prefix as MIB-I)
= GHMPY2-TM

mib-2 OBJECT IDENTIFIER ::= { mgmt 1}

-~ textual conventions

DisplayString ::=

QCTET STRING

-- This data type is used to mode! textual information taken

- . n. -

Figure 71

4. How to print an MIB Source file:

After opening the MIB Source file by left-clicking “MIB Source” under File left-click
on “Print.”

5. How to save an MIB Source file:

Under “File” left-click on “Save” or “Save As”
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6. How to delete an MIB Module:

Highlight MIB Module. Under “File” left-click on “Delete MIB” or right-click on
MIB Module and left-click on “Delete MIB.”

x

Are waou sure to remove Q-BRIDGE-MIE from database?

Figure 72

7. How to set MIB Module font:

Under “View” left-click on “Set Module Font.”

86



D-View 5.1 User’s Guide

Font style:
IHeguIar
S Serif Italic
H MT Extra Bold
B OzHandicraft BT — | Bold Italic
(} Palating Linotype
H PhingLill
H PosterBodoni BT LI
— Effects — Sample
[ Shikeout
AaBbY
[~ Underline = vz
Calor:
I- Black LI Script:
I'W'e&tern LI
Figure 73

8. How to set MIB Module background color:

Under “View” left-click on “Set Module Color.”
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Bazic colors:

Cuztom colors:

Define Cuztom Colors > "

ak Cancel |

Figure 74

9. How to set the MIB Module tree-view display font:

Under “View” left-click on “Set MIB Tree Font.”
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Font e d B3
Font style: Size:
IFHegular IEI | Ok, I
|
Italic Cancel
T MT Extra Bold "
B OzHandicraft BT _1 |Bold Italic shp |
r__Ié?} Falatino Linotype
PringLill
T PosterBodoni BT ~| =1
— Effects — Sample
[T Stikeout P
I Underline = Wiz
LColor:
I- Elack ;I Scripk:
I"v'-.-"estern ;l
Figure 75
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10. How to set the MIB Module tree-view display color:

Under “View” left-click on “Set MIB Tree Color.”

EBasic colors:

BT BT
HTECEN N
HETFTEETEN
EMfAEEEENn
EENEEEEEE

Custom colaors:

Define Cuztor Colars = “

Ok Cancel |

Figure 76.
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Creating a topology

The Topology diagram creation program included with D-View 5.1 is used to graphically
represent planned or existing networks to aid network design. This program is designed to be
flexible and easy to use. The primary tool for this application is the mouse. Topology diagrams
can incorporate user created symbols. You can also use live device icons copied from any domain
in the network. The diagrams may be further customized with user selected icons and bitmap files
used for the background.

Create a New Topology

To create a new topology right-click on the Topology icon in the Tree View display panel.

Step 1: Right-click on “Topology”

91



D-View 5.1 User’s Guide

. =I5
@ Svatern View Edit BIE: Tool: Aceount Window Help - |ﬁ'|5|
Toal I Uzer Definel
— o] 7 [m] ]
A% 10.9.68.31
% 10.9.68.80
B 10.9.68.91
“"" 10.9.68.97 (2
10.90,90.90 (£
F--I# HP
-Gl Microsoft
[]--mwnd B oreell
[]---a Marzaoni
% Fanearite |
Basic Tnfoomation
1 I
el ew To
Meszages I Trap:
————
P 10.50.821 =22/ - 02.03.28 =
IP: 10.36.56.86 East F0Z07-28
IP - 10.90.90.90 Delete 020628
IF:10.50.82.1 020328
IF: 10.90.90.90 Bepolling F0204:28
IP-10.48824 EistV' p 020428
IP:10.1.15 i F 020258
IP: 10.36.56.86 iz connected &t FF 02:03:28
IP: 10.90.90.90 is connected  at FEF 02:02:58 ﬂ

Figure 77.
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Step 2: Name New Topology

ﬁl Mew Topology

Topology Mame

Ok

X

Inew

Cancel

Figure 78.
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Step 3: “New” Topology Established

SFI D-¥iew 5.1 - [ Topology of new]

@gystem Wiew Edit [MEs Tools Account Window Help _|ﬁl|1|

Toal | User Define |

=lol x|

Ethernet
CompanyGroup
Faworite
Topology

s |
- v|C:}|T|E|é"?|
i] 100 20

100
200
El
[C400
[ 500
600
700

[ 500

hild

0 300 400 800 'E00 OO0 'e00 1500 MODO M100 M200 W300 1400 WS00 MEOO |

Messages | Traps I

Figure 79.
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Manipulating Icons and Images

Use the “Tool” pad and “User Define” pad under the tool bar to manipulate icons and images in
your new topology.

=10l
1D Srtom ow Ede L0 ) ST
B/ & ||y 1o |vemDee]
R8[o[2m —-o|tE|o
+ 4B Elberel
v il ConporyBioup Fim
Favarie
2 ook L.
i rew b
[0
100
[ 500
B
[0
200
n -t
L) *
Mssages | Trags |
7104761160 it dsconnected ol T T DGARZS =
POLEESE  w deconecled ol TF U543
112230 is dsconnecied at TF 064355
24601 is disconnected ot TF 06:4255
k) s dhsconnecled ol T4 U625
424110 is dsconnecied at TF 064255
(1042521 is disconnected ot TF 06:4255
P 0430 dreconnecled ol T4 064255
F (54755 =

P 1041 8310 is disconnecied at

Figure 80.

1. Tool tab

The Tool tab presents a number of tools used to select and move items in the diagram. This
guide discusses its functions from left to right order on the tab.

Left-click on “Tool” icon to bring up Tool tab:
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£% D-view 5.1 - [ Topology of new] o =] ]

@gystem Wiew Edit [1IEs Tools Account  Window Help _|ﬁ'|£|
Toal |UserDefine|

Ethernet
ComparyGroup 100
Favorite [
Topology |
....... Ba frew 200
[ 200
(400
[ 500
600
[ 700
[ 200
[ann ha
il | ;l_l
Messages |Traps |
IP:10.35.56.95 iz connected  at FF 06:58:25 -
IP:10.47.61.168 iz cormected  at T D6:57:55

IP: 10.36.56.96 it disconnected at F 4 06:57:25
IP: 1047611628 iz discornectad at < 06:54:55
IP:1011.22202 iz disconnected at F<F 06:54:25
IP:10.47.61.168 iz connected  at FF 06:52:55
IP:10.11.22.202 isconnected  at F4F 06:52:55
IP: 10.35.56.86 iz connected  at FF 06:51:25
IP:10.10.27.90 is connected  at F4F 05:50:25 j

Figure 81.

a. Connecting Objects

Objects can be connected using a choice of visually distinct lines, solid lines,
dotted lines etc. These lines will remain attached to the connected objects if the
object is moved around the diagram.
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To connect objects first click on the “line” icon in the toolbar. Clicking on the
“down” arrow to the right of the line icon gives you a choice of lines to use in your

drawing.
£% D-View 5.1 - [ Topology of new] - |E||i|
@ Swstern  Wiew Edit [MIEs  Tools  Account  Window  Help - |ﬁ'|5|

Taal | User Define |

Ethernet
ComparyGroup  --- pash
Favorite
—= DotDash E
Topal L )
DTk kg Mk
....... Ba new — e
E D New0hj
—
-
L]
[ 600
[ E00
(700
[ a0n
[ 9nn h
1 P | 3|
Messages | Traps |
IP: 104473240 izconnected st FF 072766 il
IP:10.10.27.90 is connected bt F4F 07.27:.55

IP: 104761168  iscornected at T O7:27:25
IP:10.1.1.181 is connected  at FOF 07.27.25
IP:10.1.1.163 is connected  at FF O7:26:55
IP:101.1.176 is connected  at FF O7:26:55
IP:101.1.168 iz connected  at FF O7:26:25
IP:101.1.158 iz connected  at FoF O7:26:25
IF:10.1.1.180 is connected  at T4 07.26:25 LI

Figure 82.
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Left-click on origin object.

Release.

Drag line from point of origin to destination object.

£% D-view 5.1 - [ Topology of new] o =] ]
@ Systemn  Wiew Edit [IEs Tools Account Window Help o |ﬁ' |5|
Toal | User Definel
Ethemet
- ComparyGraup 100
F avorite W" i
Topalogy - ol
oo iy iy
NewOb] MNEwWOhj
[ 200
[ 400
[ 500
600
[ 700
[ a00
[ann hd
J | Ll_l
Meszages |Traps I
IP:10.42.7.45 iz dizcornectad at FoF 07:06:25 ﬂ
IP: 104294126 izconnected  at F4F O7:06:25
IP:10.40.97.3 iz disconnected at F4F 07:06:25
IP: 10.47.55.77 iz disconnected at F4F 07:06:25
IP:10.254.254.251 iz connected  at T4 07:06:25
IP: 10.48.62.90 iz disconnected at F4F 07:.06:25
IP:10.48.62.91 iz disconnected at F4F 07:.06:25
IP:10.1.1.181 is connected  at F4F 07:06:25
IP:10.1.1.183 is connected  at F4F 07:06:25 ﬂ
Figure 83.
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Left-click on destination object.

A line should appear connecting both objects.

£% D-¥iew 5.1 - [ Topology of new] - 10 x|
@ Swstem  Wiew Edit [IEs Tools Account  Wwindow Help - |ﬁ||1|
Taal | User Definel
Ethernet
CompanyGroup 100
Favorite:
Topology L Ll
EQ new & X D{mk
TR NEwOhj
[ 200
[ 400
[ 500
[ &00
[ 700
N
[ ann T
il | i
Messages I Traps |
IP:10.42.7.45 is connected  at F4F 07:06:55 ﬂ
IP:10.42.94.42 is connected  at F4F 07:06:55
IP:10.4097.3 is connected  at F4F O7.06:55
IF:1038.221.7 iz dizconnected at F<F O7.06:55
I 10.34.55.11 iz dizconnected at F<F O7.06:55
IF:10.40.2.200 iz disconnected at F<F 07.06:55
IP: 10.49.66.1 iz disconnected at F9F 07:06:55
IP: 10.48.62.91 iz connected  at FF 07.06:55
IP: 10.9.68.31 iz disconnected at T4 07.06:55 LI
Figure 84.

Note: vYou need to click on open space to discontinue drawing. Otherwise you will
continue to be in drawing mode. You can also double-click on the line drawn to undo.
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b. Creating a new domain

You can click on the white bubble to place a new domain on the topology.

§f1 D-¥iew 5.1 - [ Topology of new] - |EI|1|
@ Swstem  Wiew Edit [Es Tools Account indow  Help - |ﬁ'|1|
Taal | User Define |
Ethernet
CompanylGroup 100
Favarite 3
[ 3
Topobogy o ) Mk
....... Ba new ] I
MewObj L
| MewObj
300
[ 400
[ 500
[ 600
[ 700
[ ann
(9N h
i | 2
Messages |Traps |
IP:10.44.73.33 is disconnected at F4F 07:30:55 ﬂ
IP:10.39.79.100  isconnected  at F9F 07:30:55
IP:10.49.66.1 is disconnected at F4F 07:30:55
IP: 10132245 iz connected  at TOF 07:30:55
IP:10.1.1.162 iz disconnected &t F2F 07:30:55
IP: 101679179 is disconmected at F2F 07:30:55
IF: 10,47 55,77 iz dizconnected at F4F 07:30:25
IF: 104765100 iz disconnected at T4F 07:30:25
IF:104765.103 iz disconnected at T4F 07:30:25 =l

Figure 85.
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c. Writing text

Left-click on the text tool “T” to select the text option then left-click again
diagram to place a text box on the diagram.

£% D-Yiew 5.1 - [ Topology of new]

@ Swskern  Wiew Edit  [1IEs Tools Account Window Help

o [=[ ]
===

FERFEIC

peaffl 4 ﬂl* [ 8 Toal | User Define |
=[O r[@]]

=
E‘ES Boaot 1]
Ethernet
CompanyGroup 100
Favarite
Topology L
....... Eé new 200
300
(400
[ 500
[ 500
700
(800

SN
A

Messages | Traps I

Figure 86.
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Left-click once on the text to move text around. Text will be highlighted in red
rectangle.

[ Topology of new] ;IEI ll

@gystem Wiew Edit [MIEs Tools Account Window Help _||5'|5|
Toal |UserDefine|

Ethernet
ComparyGraup M0
Favorite r =
Topol i itk
...... gt g
e ek MewOhi
=
(400
[ 500
(600
[ 700
(200
[ 9nn h
il | o
Meszages I Traps I
IP:10.24.60.1 is disconnected at 4 07:42:31 il
IP:10.42.39.10 is disconnected at 4 07:42:31

IP: 10424110 is disconnected at 4 07:42:31
IP: 1042521 iz disconnected at FoF 0742231
IP: 104351100 is discornected st F2F 0742231
IP:10.41.29.10 iz disconnected at FoF 0742231

IP: 1044671 is disconnected at 4 07:42:31
IP: 104473111 iz disconnected at T4 07:42:31
IP: 10.47.44 50 iz disconnected at 4 07:42:31 =l

Figure 87.
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Left-click twice on the mouse to edit the text.

£% D-View 5.1 - [ Topology of new] o ] [
@ System  Miew Edit [1IBs Tools Account Window Help - |ﬁ'|l|

Toal | Uszer Define I

Ethernet
CompanyGroup 100
Farvorite D '[ink
lllllll T;'mbgy 200 oo |
23 new NewQbj
[ 200
Text
[ 400
[ 500
[ &0
[ 700
[ &00
[ ann hd
i | o
Messages | Traps |
IP: 10.44.73.33 is disconnected at T4 07:44:31 3
IP: 10,427 45 is disconnected at F4F 07:44:31
IP:10.44.73.38 is disconnected at 4 07:44:31
IP:10.47.44.28 is disconnected at 4 07:44:31
IP: 10.36.56.56 is disconnected at F4F 07:44:31
IP: 10132245 iz connected  at TOF 07:44:31
IP:10.963.20 iz connected  at TEF O07:44:31
IP:101.1.183 iz connected &t TF O07:44:31
IP:10.1.1.172 iz connected &t FF 07:44:31 =l

Figure 88.

To delete text left-click once then right-click on text to bring up “Delete” option.
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d. Selecting multiple items
The multi-select tool (rectangular-shaped icon on tool pad) enables you to select a

number of items (holding the left button down to select) and move these items as a
unit.

e. Selecting individual items

You can click on the “hand” icon to select individual items.

2. User Define Tab

Importing Icons

Icons from any of the domains may be used in the diagram simply by selecting and
copying them and pasting it into the new diagram.

Step 1: Left-click on “New” under “User Define”
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-¥iew 5.1 - [ Topology of new]

@iystem Wiew Edit [1Es Tools Account Window Help

Etherret
Compary
Farvarite

Topology

Toal | User Define |

Group 100

300
400
500
[ 500
700

[ 500

:ﬂ‘“lﬂ

Messages | Traps |

: 10.36.56.56
1 10.47.61.168
10365686
C10.47.61.168
10122202
S10.47.61.168
2101122202
: 10.36.56.56
:10.10.27.90

iz connected  at F°F 06:58:25
iz connected  at F°F 065755
is disconnected at T4 065725
iz disconnected at FF 06:54:55
iz dizconnected at F<F 06:54:25
iz connected  at FF 065255
iz connected  at FoF 0B:52:55
iz connected  at F°F 06:51:25
is connected  at 9 05:50:25

Figure 89.
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Step 2: Allows you to bring up icon to be imported

open 2| x|
Lock in: | 3 Map |« @ ek E- (331388 [
@hsinchu

i v,
=3
R L L

JEmE
e SrduEFA

wE T .
e R a
Ty a A raid °

ol
FUEEY]

File name: Im Open I
Filez of type: IJF'G j Cancel |

Figure 90.

Step 3: Drag domain icon into workspace. Pictured below is the default D-Link
“New Object” icon
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@S_\,.rstem View Edit [MIE: Tool: Account Window Help _|E|£|

|Jzer Define |

il Ethermet
ComparyGroup 00
Favorite
" Topology

| 200 e

Mezzages |Traps I

Figure 91.

107




D-View 5.1 User’s Guide

An Example: Creating a Topology Diagram

Step1: Click on New Topology

g‘, D-View 5.1 - [ListVi
@ Swetern ¥iew Edit MIE: Took Accownt Window Help

ﬁ Taol |UserDefine|

=101 x|
=l=1x]

— Oz @[]

== 10.9.68.80

=] 10.9.68.90

Sz 109.68.91
= 10.9.68.97 (80

[ E 10.90.90.90 ¢

= [ HP

- Ell Microsoft

[ mwna B vl

B

jg b arconi
----- % Favarite |
..... w

B Information
K1

IP: 10.36.56.56 is connected  at F4F 02:03:28
IP: 10.90.90.90 iz connected  at P4 02:02:53

05082 1 Copy E 1120926 =
IP: 10366686 | Dot - 020728
IP:10.9090.90  Delet 020628
P 1050E21 - tpzosoe
IP 10808090 Bepeiing - 020428
P:1048824 | oo , 020428
IP 10115 L 020358

Figure 92.

Step 2: Name new topology and press OK.
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T opology Marme 0K

iS cFark. Cancel

Figure 93.

Step3: New Topology created:

g 3
(X Swstern  Wiew Edit MIB: Tools Account Window Help

Tool I User Define I

_1ol x|

10.49.66.1
10.5.2.62
10.9.68.107 B
10096231
10.9.62.80 L
10.9.62.90 =L
10.9.62.91
10.9.68.97 (20 [ 200
10.90.90.90 [t
E HF 400
Bl Microsoft
e [ ool -
E]---g M arconi 500
Favorite
= Topology [ 600
B
T 7nn
< 1 oom =0 |
Mezzages I Traps I
IP:10.50.82.1 iz disconnected at F9F 02:09:28
IP: 10.36.56.85 iz disconnected at F°F 02:07:28
IP: 10.90.90.90 iz connected  at FF 02:06:28
IP:10.50.82.1 iz connected  at TFF 02:05:28
IP: 10.90.90.90 iz disconnected st “F“F 02:04:28
IP: 10.45.52.4 iz connected  at F<F 02:04:28
IP:10.1.1.5 iz disconnected at F<F 02:03:58
IP: 10.36.56.86 is connected  at FAF 02:03:28
1P : 10.90.90.90 iz connected  at FF 02:02:58

Figure 94.
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Step 4: Import background picture by clicking on “New Background Picture.”

E g e _Inli’
@_ystem Yiew Edi BMIE: Tools Account Widow Help _Iﬁllﬂ
'ﬂl *l li Tool | Lzer Defmel

—_— v|C:}| T |EI|€“’?|

e 1043661 &

700 laon 800 [ooo Moo 2000 300 1400 o

m 1056262
«:"’ 10.9.68.101 (100 :
- 10.9.68.31
== 10.9.68.60 B
=
-—-{P= 10.9.68.90 =00

- B5 109681 L
e 100.9.60.97 (8 300
10.90.30.90 [

B-LE HP | Modjfy Barlormmmd Fize
= 400
-l Microsoft Remave Backgromnd Picture
- mwat Movell ks Background Color

tarconi 500 Grrid

----- Favarite 1
= Topolo &00

[ 700 il
q okl | ]

Mezsages | Traps |

IP: 10.50.82.1 iz disconnected at FF 02:09:28 -
IP; 10.36.56.86 iz disconnected at F4F 020728
IP:10.90.90.90 iz connected  at F4F 02.06:28
IP:1050.821 iz connected  at TR 02:05:28
IP: 10.90.90.90 is disconnected at 9 02:04:28
IP:10.48.824 iz connected &t TOF 0204:28

IP:10.1.1.5 iz dizconnected at FF 020358
IP: 10.36.56.86 izconnected  at FAF 020328
IP:10.90.90.90 iz connected  at F4F 020258 LI

Figure 95.
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Step 5: Import .jpg or .bmp file

Messages l Traps |

_|of x|
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& o [Eretiipe Bflewshunlipg BT nodthl jpg B it fpg
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B EHP B francel jpg B middle jpg Lifsc 2 | tadpei ipz
gl Microsoft Ehmmhu.]pg @’m.tddlel.jpg @’s:uuth.]pg g tadwnll 4p.
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% Eavciite A IScPaIk_]pg @
B[ Topology  $5z2sBA(Ty [IPEG Image Fils (*jpg) =] Brif | .
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4 | _’|J J | 3

IP: 10115 iz disconnected at FF 02:14:58
IP:1090.90.90 iz disconnected at T4 02:14:28
IP:10.41.441 iz connected  at T 02:13:28
IP:101.15 iz connected  at TOF 02:13:28
IP: 1050821 iz disconnected at F4 02:09.28
IP: 10.36.56.86 iz disconnected at 9 02:07:28
IP: 10.90,90.90 iz connected  at T 0206:28
IP: 1060821 iz connected  at F4F 02:05:28
IP: 10.90.30.90 is disconnected at T 02:04:28

Figure 96.
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Step 6: Set background size and press OK.

ul Bize

{* Real Size (2240 % 1600]

(" Custorned Cancel |

"idth[1000...B000] I

Height[1000...28000] I

Figure 97.
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Step 7: Background picture imported

L] ; :
@ Bwstern Wiew Edit MIE: Tools Account  Window

c ﬂ *li Taol |L|serDefine|

Help

E M arconi

Favorite

sanm — 1o =

500

EL
|

Meszages | Traps |

{ndl]

.

N\'\
o Y =y

IP:10.41.441
IF:101.1.5
IP: 10.90.90.90
IF:10.41.441
IP: 10.48.62.90
IF : 10.48.62.31

is disconnected at F4F 02:35:28
is connected &t FF 02:33:58
is disconnected at FF 02:32:58
iz connected  at T 02:31:58
is connected &t T 02:30:28
is connected  at F4 02:30:28

Figure 98.
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Step 8: You can drag devices directly from Tree View onto the Topology diagram or copy
and paste.

T 1ol

@ Swstern  Wiew Edit LiIE: Tools Account Window Help I el e |
Tool |UserDefine|

Bl Microzoft
[ mmed Mawell

g tarconi

Faworite | E00
= Topalogy o
2 700
[ 800
IR 3. [ 300
A I d|
Mezzages | Traps I
IP: 10.36.56.86 iz disconnected at 4 02:38:58 ﬂ
IP:101.1.5 iz disconnected at 4 02:33:28

IP:10.90.90.90 iz connected  at T4 02:37:58
IP: 1010010010 is disconnected at 4 02:37:28
IP: 10.36.56.86 iz connected  at T4 02:36:58
IP:10.41.441 iz dizconnected at T4 02:3%:28 LI

Figure 99.
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Step 9: Use the line function on the tool pad to connect devices in the topology drawing
and set colors.

i ] - o] x|
@Sﬂstem Wiew Edit LBz Tools Account Window Help _|E|5|
A & |F ﬁ Li Tool |UserDefine|
O] il =15

0
100
200
300
_4DD__
500,
-2 Marcari £
gt Favarite 600
=2 Topology e
E'E& ] ;

Mezsages |Traps |

IP:10.1.15 is connected  at FF 02:41:28 3
IP: 10.36.56.95 is disconnected at FoF 02:38:58
IP:10.1.1.5 iz dizconnected at FoF 02:38:28

IP:10.90.90.90 iz connected  at R 02:37.58
IP:10.100100.10 iz discomnected at F 9 02:37.28
IP: 10,3E.56.86 iz connected  at B4 02:36:58 LI

Figure 100.
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Step 10: Save to Database

[E =Y

£BT

(=Y
el

: i)
A Bvstern View Edit BMIB: Tools Account Windew Help
Discover ser Define |
Al Bazic Information
| |=| e
Repolling Configuration
Community Streing Confignre

1]

Meszages | Traps |

IP:1011.94.224 iz disconnected at F=F 02:41:58 il
IP:10115 is connected  at B 02:41:28
IP: 10.36.56.86 iz disconnected at T4 02:38:58
IP:101.156 i disconnected at T4 02:38:28
IP:10.90.90.90 is connected  at F°F 023758
IP: 1010010010 iz disconnected at F9F 02:37.28 ﬂ

Figure 101.
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MIB UTILITIES

This chapter explains how to use MIBs tools and other utilities located under the MIBs drop-down
menu. It is organized according to the top to bottom, left to right order of the menu items. These
menus will allow you to view statistics and to configure Layer 2 and Layer 3 functions. For many
of the menu items an information table (RFCs—technical reports called Internet Requests for
Comments) is presented along with a path diagram to illustrate how to utilize the particular
functionality.

Note: In order to use MIB Utilities you need to first select an SNMP-enabled device.

The menus in this group include:
e Device SNMP Configuration
e MIB II Information and Statistics Windows
e [F MIB Information Tables
e Entity MIB Information Tables
e Bridge 802.1d Information and Port Configuration Table

e Spanning Tree Information and Port Configuration Table
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e Transparent Bridge Forwarding and Static Filter Tables and Port Counter
e RMON Statistics, History and Event Windows
e 802.1p Priority Configuration Including GMRP and GARP

e 802.1Q VLAN Information and Configuration Including Forwarding/Filtering and
Unicast/Multicast Configuration

e Port VLAN Traffic Statistics

e Layer 3 Utilities Including IP Forwarding, RIP2, OSPF, IP Multicast, DVMRP and PIM
Configuration

e SNMP Configuration

Device SNMP Configuration

You can change the SNMP configuration of the device. Otherwise you will use the default settings.
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£% Device SNMP Configuration x|

B 1011153 Pot 157 "SNMP Pratacal Version
v SHNMPw1 " SHMPw2c & SHNMPv3

Secwrity Mame: Inu:u.&uthLl 28 j Context Engine |0: ||:|-| 0000a]dd

Auth Password: I.-'-‘-.uthF"asswclrd Brivv Pazsword: IF'rivF"asswclrd

Auth Protocal; INEINE j Py Protocal; INEINE j

Read Community String : Ipub",: Security Lewvel IND.-'-‘-.uthNDF'riv j

"Write: Community String ; Iprivate

ak. Cancel |

Figure 102.

MIB Il Menus

MIB II pop-up menus are accessed as side (client) menus and can be viewed alone. You can also
have multiple windows opened simultaneously.

Information

Use the MIB II Information window to view and write basic device SNMP information.
Enter the following:

e System Contact,

e System Name
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e System Location
Type in the new text and click on set to make these change effective.

£% MIB Information Table : 10.1.1.141 Ol =|
Syztem Descriphion |D-Link DHS-3224W Ethernet over WDSL Switch
Spztemn OID 1.361.41.171.10.38.2
Syztem Up Time |2 days, 2337 04:48 Set
System Contact
Spztern Mame
System Location
System Service |3
ek DISMMP ¢ Okl Request: Receive at 05:40:31 PM, 4

Figure 103.

The remaining menus under MIB II are the following read-only table and counter windows
(examples pictured on next page):

IF Table

IF Counters

IP Counters

IP Routing

IP Address Table
ICMP Counters
UDP Counters
SNMP Counters
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MIB II Read-only Windows

Read-only menus can be refreshed, reset and paused; you may adjust the poll interval for the
counters. A few examples screen captures are pictured here:

o

‘:nde:-c I E:Sgrip:i;n = I = Syztem Time
sical For I-Fi

2 Physical Part 2 SlLEANEN

3 Phyzical Port 3

4 Phyzical Port 4

5 Phyzical Port 5 e

E Phyzical Port B

7 Phyzical Port 7

o Db =l ek 2 LI

Index [1 Description |F'hysic:al Part 1

MName I Yalue I Delta I Rate I Feak I FPeak Occure... | Pl rtizre

InDctets E0497 702 70 70 AF0 AR 08:11:11 I1 jv

InUcastPkts 43525 1 1 1 TR 081111

InMU zaztPkts 43831 3 3 3 A 02:11:11

InDiscards 5 0 0 0 F4F 08:11:10 Resst |

InE mors i i i a TFF 08:11:10

IndrknovwnPro.. 0 n n a T 03:11:10 Start |

OutOctets TE29599932 102204 102204 102204 T4 02:11:11

OutldcaztPkts 44487 0 0 0 TF-F 08:11:10 Pause |

OutlUcastPkts | 3005035 325 325 325 TR 081111

OutDizcards 0 0 0 0 T4 02:11:10

OutE rrors 0 0 0 0 F4F 02:11:10

Geb:DISMMP @ Okl Request: Receive ak 08:11:11 FF., v

Figure 104. Example of MIB II Read-Only Menus
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ol
M arne | Walue | Delta | Fiate | Peak. | Peak Dccured at | St T
iplnReceives 266321 433 438 Ha0 F4F 08:11:65 I-Fi 5
iplnHdrE rors 0 0 0 n FH 08:11:50 miatihlilE
iplnaddrE mors 0 0 0 n FH 02:11:50
ipForwDatagrams 0 1] ] 1] T4 02:11:50 -
iplnUnknownPratals 0 1] ] 1] T4 02:11:50 Pall Interval
iplnDizcards 1027 1] ] 1] T 02:11:50
iplnDelivers 265794 438 434 540 F4F 02:11:55
ipOutRequests 77 2 2 2 F4F 0%:11:51 Reset
ip0ulDiscards 0 0 0 0 F4F 08:11:50 Eee
ipOutMoR outes 0 0 0 n FH 08:11:50

Start

i

Pauze

|Get:DISHMP ; Ok Request: Receive at 05:11:56 F2F,

Figure 105.
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£% 1P Routing : 10.1.1.153 =10| x|
ipAoutelest | ipRoutelflndes | ipRouteMetic] | ipRoutetetic? | ipRouteteticd | ipF

0.ono 256 1 -1 -1 -1

10.0.0.0 256 1 -1 -1 -

« I M

(Get:DISMMP ¢ Okl Request: Receive at 06:12:26 F2F,

Figure 106.
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£ 1 add = B — 13l =<
ip#dE nksddr | ipesdEntlflnde= | ipesdE nttettd ask ipdE ntE castéddr || ipfdE ntF easmbd
10.1.1.153 256 Z55.0.0.0 1 G5535
- | | (|

[(Seb:DISMMPE @ Okl Requesk: .Receive ak 05:135:05  F 2. _E

Figure 107. Figure Examples of MIB II Read-only Menus

IF MIB Tables
The following table gives a brief description of the IF MIB:

IF-MIB (RFC 2233)

1. The ifGenerallnformationGroup. This group contains those objects applicable to all
types of network interfaces, including bit-oriented interfaces.

2. The ifPacketGroup. This group contains those objects applicable to packet-oriented
network interfaces.

3. The ifFixedLengthGroup. This group contains the objects applicable not only to
character-oriented interfaces, such as RS-232, but also to those subnetwork
technologies, such as cell-relay/ATM, which transmit data in fixed length transmission
units. As well as the octet counters, there are also a few other counters (e.g., the error
counters) which are useful for this type of interface, but are currently defined as being
packet-oriented. @ To accommodate this, the definitions of these counters are
generalized to apply to character-oriented interfaces and fixed-length-transmission
interfaces.
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It should be noted that the octet counters in the if Table aggregate octet counts for
unicast and non-unicast packets into a single octet counter per direction
(received/transmitted). Thus, with the above definition of fixed-length-transmission
interfaces, where such interfaces which support non-unicast packets, separate counts

of unicast and multicast/broadcast transmissions can only be maintained in a media-
specific MIB module.

Table 2.

The IF MIB General Information and IF Stack tables:

£% ifCeneral Table : 10.16.79.36 - (0] x|

IF Table Last Change  |0:00:00:00

IF Stack Last Change  |0:00:00:00

!Get:DlSI'IMP : Okl Bequest: Recedve at 02:27:15 F.

Figure 108
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£B i Table - 10.16.79.36 -0 x|
findes | iMame | frtulticastPkes | frBroadcastPkes | f0utdullicastPkes | fOutBro:
4207230 F20388 1974

Set

L0 I S R R P B 0

e
(W}
=

510473 BO264

e Ay
- ]
o s T B e e s O e s O e e T s Y e s
0 e e e w8 e Y T e S e o S Y e S5 e e v Y e 6 e s |
5w 8 M S R 0 Y S o o R S i S e S i e |
0 s e R e w8 e e e o e e e e e v e s Y |
-
4

LirkUp/LinkDown Trap | j Alias

[T Promizcuous Maode

{GetDISNME : Ok! Request Receive at 02:23:24 . v

Figure 109.

To enable Link Up/Link Down Trap, assign an Alias or enable Promiscuous Mode highlight the
appropriate index and supply the information at the bottom of the menu.

126



D-View 5.1 User’s Guide

Entity

The following table gives information about the Entity MIB:

Entity MIB (RFC 2737)

- Logical Entity
A managed system contains one or more logical entities, each represented by at
most one instantiation of each of a particular set of MIB objects. A set of
management functions is associated with each logical entity. Examples of logical
entities include routers, bridges, print-servers, etc.

- Physical Entity

A "physical entity" or "physical component" represents an identifiable physical
resource within a managed system. Zero or more logical entities may utilize a
physical resource at any given time. It is an implementation-specific manner as to
which physical components are represented by an agent in the EntPhysicalTable.
Typically, physical resources (e.g., communications ports, back planes, sensors,
daughter-cards, power supplies, the overall chassis) which can be managed via
Functions associated with one or more logical entities are included in the MIB.

- Containment Tree

Each physical component may be modeled as 'contained' within another physical
component. A "containment-tree" is the conceptual sequence of entPhysicallndex
values which uniquely specifies the exact physical location of a physical component
within the managed system. It is generated by 'following and recording' each
‘entPhysicalContainedIn’ instance 'up the tree towards the root', until a value of zero
indicating no further containment is found.

Table 3.
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Figure 110. Entity Logical Table
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t,‘f"- Phorsical Tahle ; 1024 22 8 = IDIEI
entPhyzicallndex | entPhyzicall ezcr I entPhysicalfendorType &
D-LIME DHS-322 1.36.7:4.1.171.10.36.1. 3.1 |_ET
2 D-LIME Base Moduls[DHS-3226] 1.36.1.4.1.171.10.36.1.4.1
3 D-LINE Slot 1 1.361.4.1.171.10.36.1.6.1 Sample
4 D-LINE UTP-10A00M Mway port 1 1.36.1.4.1.171.10.36.1.5.1
5 D-LIME UTP-10A100M Mway port 2 1.36.1.4.1.171.10.36.1.5.1
5 D-LIME UTP-10A00M Mway part 3 1.36.1.4.1.171.10.36.1.5.1
¥ D-LINE UTP10A100M Nway port 4 1.361.41.171.10.36.1.5.1 Refresh
B D-LINK UTP-10A100M Mway pot 5 1.36.1.4.1.171.10.36.1.5.1
g D-LIME UTP-10100M Mway pot 6 1.36.1.4.1.171.10.36.1.5.1 =
10 D-LIME UTP-10A00M Mway port 7 1.36.1.4.1.171.10.36.1.5.1
11 D-LIME UTP10A00M Mway port 8 1.361.4.1.171.10.36.1.517
12 D-LINE UTP-10A00M Mway port 9 1.36.1.4.1.171.10.36.1.5.1
13 D-LIME UTP-10100M Mway port 10 1.36.1.4.1.171.10.36.1.5.1
14 D-LIME UTP-10100M Mway part 11 1.36.1.4.1.171.10.36.1.5.1
15 D-LINE UTP-10100M Mway port 12 1.3.6.1.4.1.171.10.36.1.5.1
16 D-LINK UTP-10100M Mway port 13 1.36.1.4.1.171.10.36.1.5.1
17 D-LINK UTP-104100M Mway port 14 1.361.41171.10.361.51
A LRI TITOAOMNNRA Bl mmek 1R T2CcTtAd A7 1021 EA
4 PI
Sernal Mumber |[NL|LL] Aliaz I[NLlLL] Azzet 1D I[NLILL]
Get0kl RequestPhosical Table Received at03:29:53 F4F. o

Figure 111. Entity Physical Table
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Bridge 802.1d

Bridge 802.1d Information and Port Table

First some Bridge 802.1D (RFC 1493) MIB Group Definitions:

Bridge 802.1D (RFC 1493) MIB Groups

The dot1dBase Group

This mandatory group contains the objects, which are applicable to all types of bridges.

The dot1dStp Group

This group contains the objects that denote the bridge's state with respect to the Spanning Tree
Protocol. If a node does not implemented the Spanning Tree Protocol, this group will not be
implemented.

The dot1dSr Group

This group contains the objects that describe the entity's state with respect to source route bridging. If
source routing is not supported this group will not be implemented. This group is applicable to source
route only, and SRT bridges. This group will be described in a separate document applicable only to
source route bridging.

The dot1dTp Group

This group contains objects that describe the entity's state with respect to transparent bridging. If
transparent bridging is not supported this group will not be implemented. This group is applicable to
transparent only and SRT bridges.

The dot1dStatic Group

This group contains objects that describe the entity's state with respect to destination-address
filtering. If destination-address filtering is not supported this group will not be implemented. This
group is applicable to any type of bridge which performs destination-address filtering.

Relationship to Other MIBs
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As described above, some |IEEE 802.1d management objects have not been included in this MIB
because they overlap with objects in other MIBs applicable to a bridge implementing this MIB. In
particular, it is assumed that a bridge implementing this MIB will also implement (at least) the 'system’
group and the 'interfaces' group defined in MIB-II.

Relationship to the 'system' group

In MIB-II, the 'system’ group is defined as being mandatory for all systems such that each managed
entity contains one instance of each.

Table 4. Bridge 802.1D (RFC 1493) MIB Group Definitions

Bridge aging time can be adjusted in the Information window; otherwise Bridge 802.1 windows are
read-only.

Bridge 802.1d Information : 10.15.1.66 - x|
Bridge Address O020CE000006
ke of Pore 0 ....... e
Bridge Tvpe tranzparent-anly S et |
Learned Entry Dizcard 0
T-Bridae Aaqing Time | 300

(10-1000000])

(Get:DISHMP++: OkIRequest: Receive at 03:22:23 PM,

Figure 112. Bridge 802.1d Information
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£% Bridge 502.1d Port Table ; 10.24.228

=100 %]

Port | Iflndex | Circuit | DelagEsceededlizcards | MtuE sceededDizcards -
1 1 oo 1]
2 2 oo

3 3 oo

4 4 oo

a] a] oo

B B oo

7 7 oo

a a oo

9 9 oo

10 10 oo

11 11 oo

12 12 0.0
132 13 0.0
14 14 0.0
15 15 0o
16 1B 0.0
17 17 0.
18 18 0.0
13 13 0.0
20 20 0.0
21 21 0.0
299 fin

!Get:DlSI'IMP 0kl Bequest: Beceive at03:33:57 F3F. v

ez b o o v L o S v ] v Y e R v S e v e A s S v ] e Y e Y v S e [ v 0 e s 28
s e ] w4 e ] e 3 e ) 68 e e o e e e e ) e e ey e )

Figure 113. Bridge 802.1d Port Table
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Path: MIBs - 802.1D Information/Port Table

Bridge 802.1D Information Bridge Address, Number of Ports, Bridge Type, Learned
Entry Discard

Port, Ifindex, Circuit, DelayExceededDiscards,

Port Table Information MtuExceededDiscards

Table 5. Bridge 802.1D Information/Port Table

Spanning Tree

Spanning Tree Information

Use the STP Information window for global changes to the selected device. User configurable
global STP settings include Priority, Maximum Aging Time, Hello Time and Forward Delay.
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mpanmng Tree Informaton ; 10024 22 8 ! EI
Bstricc] leeeB]d
Priorty (0-65535] 2  fefresh
Time Since Topology Change  B:11:37:00 S et |
Murber of Topology Changes ||:|
Diesignated Floot B000000S50F33287
Root Cost |D
Roaot Port o
t amimurn Aaging Time |2D':":'
HelloTime 200
Hold Time oo

Formard Delay |1 200

Mawimum Aging Time{500-4000] j2000
Hella Time[100-1000) 200
Forward Delayp(400-2000) 1800

FetDISNMP : Okl Request: Eecedve at 03:35:26 7.

Figure 114. Figure 2. Spanning Tree Information
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Path: MIBs - Spanning Tree - Information

Protocol, Time Since Topology Change, Number of
Topology Changes,

Designated Root, Root Cost, Root Port, Maximum Aging
Time, Hello Time, Forward Delay

Read-only Information

Maximum Aging Time(600-4000), Hello Time(100-1000),

Set Variables Forward Delay(400-3000)

Table 6. Spanning Tree Information

Spanning Tree Port Table

The STP Port Table allows you to configure STP port settings. Select the port you wish to configure
and type in the desired Priority and Path Cost for the port. The Status pull-down menu is used to
enable or disable the STP settings for the port.
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E*“ ATP Poit Table ;10 24 22 8

Fuart | F'riclrit_l,l | State I Statiz I FathCost I Designatedﬂnnt | -
1 128 forwarding  enabled 13 2000000560 Fa3287
2 128 dizabled enabled 19 2000000550 FI3287
5 128 dizahled enabled 19 AO000005R0FI3287
4 128 dizabled enabled 19 A000000550FI3287
5 128 dizabled enabled 19 AO000005R0FI3287
E 128 dizabled enabled 19 2000000550 F33287
7 128 dizabled enabled 19 2000000550 FI3287
a 128 dizabled enabled 19 AO00000R50FI3287
9 128 dizabled enabled 19 2000000560FI3287 —
10 128 dizabled enabled 19 AO0000NRR0FI3287Y
11 128 dizabled enabled 19 A000000550F33287
12 128 dizabled enabled 19 2000000550 FI3287
13 128 dizabled enabled 19 A000000560F33287
14 128 dizabled enabled 19 2000000550 FI3287
15 128 dizahled enabled 19 BO00000RROFI3Z2EY -
4| I b
Priority [0-255] |
Statuz I ll
|

Fath Cost [1-65535]

=10l x|

!E}et:DISI'IMP - Okl Request: Recedve at 03:36:57 TF 9.

Figure 115. STP Port Table
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Path: MIBs - Spanning Tree - Port Table

Port, Port Priority, State, Status, Path Cost,
Read-only Information DesignatedRoot, DesignatedCost, DesignatedBridge,
DesignatedPort, Forwarding Transitions
Set Variables Priority, Status, Path Cost

Table 7. Spanning Tree Port Table

Transparent Bridge

Transparent Bridge Forwarding & Static Filtering Tables

Highlight to select the device and access these read-only menus from the Transparent Bridge side
menu.
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£% Transparent Bridge Forwarding Table: 10.15.1.66 -0 x|

gddresz | Port | Status -

004005, 65 learn...
oo4oos... 7 learn...
004005, 65 learn...
004096.. 65  leam... o
00434E... BE learn...
004a54... BE learn...
1043854, BE l2arn...
Q0503E... BE l2arn...
Q0R0B... B l2arn...
Q0s0E... BS l2armn...
Q0s0E... BS l2armn...
Q050E... BB l2armn...
Q0s0E... BS l2armn...
Q050E... BB l2armn...
Q050E... BS l2armn...
Q050E... BS l2armn...
Q050E... BS l2armn...
Q050E... BB l2armn...

Q050B... B5 lear...
ANEME: EE lazmm j
Geb:DISMMP ¢ Okl Request: . Receive at 01:59:25 PM, v

Figure 116. Transparent Bridge Forwarding Table
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ft-'i Transparent Bridge Forwarding Table: 10.1.1.141

Addresz | Paort | Statusg -
Qoooio.. 25 leart... .
Qoooat... 25 learn...
QO00EZ.. 25 leart...
QO00EZ.. 25 leart...
QO00EZ.. 25 leart...
QO00EZ.. 25 leart...
QO00EZ.. 25 learn...
QO00EZ.. 25 leart...
Q000FS... 25 learn...
aoo103.. 25 leart...
Qo130 25 learn...
Q00196 25 leart...
QO0Z3F.. 25 | leamn...
aooss.. 25 leart...
aoosa.. 25 leart...
Qoosh.. 2k leart...
aoosa.. 25 leart...
Qoosh..  2h learn...
aoosa.. 25 leart...
MnnR& I ez ll

=10 =

Geb:DISMMP ¢ Okl Request: . Receive abt 10:52:35 AM.

Figure 117. Transparent Bridge Static Filtering Table
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Path: MIBs - Transparent Bridge > Forwarding Table/Static Table

Transpar_'ent Bridge Forwarding Table Address, Port, Status

Information

Transparent Bridge Static Filtering Address, ReceivePort, AllowedtoGoTo,
Table Information Status

Table 8. Transparent Bridge Forwarding/Static Filtering Table

Transparent Bridge Port Counter Table & Port Traffic Graph

Counter tables and traffic graphs can be paused or reset as desired. The user can change the Poll
Interval and Count, graphs may use a three dimensional line by checking the 3D Line box.
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E‘f‘ Tranzparent Brid ge Port Conter ; 10.16:79 36

dotldTpPort | dot1dT pPartt asinka |

1506
1508
1505
1506
1505

8l Tl

2
i
4
5
B

Fort Murnber [1 Max Info 1506

Fart Counter Table  Fort Traffic |

sod ) [ Input Frames |

== i i HE I T T N L e —D_utputFrames

- ! ' - ! : : ! Dizcard Frames
Sl i AR i e e PR
E e b et e bt eos Pt
I ol e e
Sl e
Sl et bt s b e FRTeT
S
R e = e
ekl s
L el et e bt
(1 e s e e o e e
0 1 2 3 4 3 & 7 g 9

=101 x|

System Time:

TFoF 0223321

Refrezh |

Fall Interwal

I'I vl
Count

I'IEI vl

[~ 3D Line

Reszet
Stark

Fauze

GetDISNME : Okl Beguest: Becedve at03:39:21 F4F.

Figure 118. Transparent Bridge Port Counter
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Path: MIBs - Transparent Bridge - Port Counter

dot1dTpPort, dot1dTpPortMaxInfo, Port Number, Max
Info
Name, Value, Delta, Rate, Peak, Peak Occ.

Transparent Bridge Port
Counter Table

Table 9. Transparent Bridge Port Counter

RMON

View RMON statistics for any port on the selected device by clicking the index (port) number. By
default the Statistics Table is displayed for index 1. Port Utilization, Error and Packet
Distribution are displayed graphically. Check the 3D Line for more readily visible graph lines.

Remote Network Monitoring Object Groups

The Ethernet Statistics Group

The Ethernet statistics group contains statistics measured by the probe for each monitored Ethernet
interface on this device. This group consists of the etherStatsTable. In the future other groups will be
defined for other media types including Token Ring and FDDI.

These groups should follow the same model as the Ethernet statistics group.

The History Control Group

The history control group controls the periodic statistical sampling of data from various types of
networks. This group consists of the historyControlTable.

The Alarm Group

The alarm group periodically takes statistical samples from variables in the probe and compares them
to previously configured thresholds.

If the monitored variable crosses a threshold, an event is generated. A hysteresis mechanism is
implemented to limit the generation of alarms. This group consists of the alarmTable and requires the
implementation of the event group.

The Event Group
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The event group controls the generation and notification of events from this device. This group
consists of the event Table and the log Table.

Table 10. RMON Statistics
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£% Rmon : Statistics : 10.15.1.66 _ =10 x|
|ridex | [rata Source | I:Iwn.er | Ste!tus | A sostem Time:
1 Iflindex.1 rnamibar walid | 0403 PM
2 [flndex. 2 rniarikor walid
3 [flndex. 3 rniarikor walid Fefresh
4 [flndex. 4 rniarikor walid EiTes
] [flndex.5 rniarikor walid Add
G [flndex. B rniarikor walid
¥ Iflndes. ¥ rnoritor wvalid b clify
a [flndex. 8 rniarikor walid
a Iflrnday O raawitar wralid =l Delete
Statistics Table | Utilization | Erer  Packet Distribution
Interval [sec]
M 64 Octets (1--3600]
B 55~127 Octets =
30 [1128~255 QOctets
W 256~511 Qctets Count[10-120]
a5 ) [ 512~1023 Octets
E 1024~1515 Octets
20
15 |
10
5 Rezet
|:| .
20354 P 20356 PM 20355 PM 20400 P 2:04:02 P oK.

Figure 119. RMON Statistic (Packet Distribution Graph)

Use the Add and Modify function to add an index or change a selected index’s variables. Clicking
the Add or Modify button will bring up the Control Table pop-up menu. The Control Table pop-up
screen is used to input index variables. Statistics information displayed may be frozen at any
point and resumed using the Start and Stop buttons.
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Path: MIBs &> RMON - Statistics

Index, Data source, Owner, Ststus, Name, Value,
Delta, Rate, Pea,
Peak Occurred At

RMON Statistics Table
Information

Table 11. RMON Statistics

RMON History

View the history table and graphs including Utilization, Error and Packet Distribution. Add or
modify and index with the Control Table.
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£% Rmon : History Form: 10.1.1.166 Y m]
Index I Data Source I Bucketz Requested I Buckets Granted I Interval I Ovrer - Sustern Time:
Iflndex. 1 160 |80 |30 | monitor S E ST
2 [Flnide. 1 a0 a0 1800 rnohitor
3 [Hndex 2 a0 a0 30 oritor Add
4 [fndex.2 a0 a0 1800 rnonitar —
5 Iflndex. 3 50 50 30 mahitor Fadify
E [flndew. 3 a0 a0 1800 rnohitor = i
7 Iindes 4 0] 50 a0 manitor = Delete
n [ [P P | [=n] [=n] RiEnlnln} P R _—
1] | _'I_I Wiew
T able |L|ti|i2atiu:un| Error I PacketDistributiunl Refresh
. . . : Interval [sec
Indes : |‘|_ [rata Source : [findex.1 Cwner : monikar (103600} 1
Time Stamp | Drop Events | Octets | Packetz | Broadcast | tulticast | CRLC Align | Undersize | Over: = I-“:I jv
2days. 14 0 ] f i 1] 1] 1] 1] Caunt[10-120]
2days, 1:5.. 0 103 12 1] 1] 1] 1] 1] |3|j| vl
2days, 1:5.. 0 a a 1] 1] 1] I o
2dayz, 1:5.. 0 a a 1] 1] 1] i i ;
Zdays. 15 0 0 0 0 0 0 0 0 [ 3D Line
2days, 1:5.. 0 a a 1] 1] 1] 1] 1]
2days, 1:5.. 0 a a 1] 1] 1] 1] I Stop
2dayz, 1:5.. 0 a a 1] 1] 1] i i
Zdays, 15.. 0 i i ] ] 0 0 0 Start
2days, 1:5.. 0 1025 8 1 1 1] 1] 1] Feset
2days.15.. O 0 0 ] ] ] ] ] B8
2dayz, 1:5.. 0 a a 1] 1] 1] i i
2dayz. 1.6 0 a a 1] 1] 1] il il -
d | N

Figure 120. RMON History Table
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£% Rmnon ; Historr; 1016 i =]
[ndew I [1ata Source I Buckets Reguested | Bucketz Granted | Intereal I Ovarer - S
e T N e VR | ' T
Iflndes. 1 50 L] 1800 monitor
[flndew.2 50 a0 30 ronitor Add
IHndex 2 il il 1800 oribor ————
[fndex.3 50 50 a0 momikar bodify
Iflndexs. 3 50 a0 1800 ronitor

[flrdes.4 50 50 30 manitar _|‘ﬂ Delete
(EFE R | ch ch ERginlal g =l ’

[ e Rt B U 5 Y S PR 8

| ’ - Wiew
Table | Utilization | Enor  Packet Distribution Refresh

Packet Distribution Interval [zec)
1I1|:||:|_...........;_.........,............;......_.._.;...........,_...... IPackets [1['"35[“:']

1|:u:u:| TR I H Broadcast |1D vI

| i : | I O hutticast
I e i (e e e e e e e el e o SR et ek Count[10-120]

goodF-1---1--|- _. T R O BN _ Y N R m
[TonE o o RN NS BN RN BN BN BN BN AN BN SE BN B BN BN BN BN BN BN SN BN BN A BN [ 3D Line
Flsab e B BN EW BN BN BN B BN BN BN NN BN UN BN BN BN BN BN N BN
fcluluje N BN BN NN NN BN BN NN B BN TN BN NN NN BN BN BN NN BN BN BN BN A BN BN B SN Start
oot R R LR RL 1 1
104K IEREREERE ] IESEEENE 1R L

2005398 G61T3562 6120260 B122954 GO95544 GBOT2235

Stop

Rezet

Ok

Figure 121. RMON History Graph
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Path: MIBs - RMON - History

Index, Data source, Buckets Requested, Buckets Granted,
RMON History Table Interval, Owner, Status, Time Stamp, Drop Events, Octets,
Information Packets, Broadcast, Multicast, CRCAlign, Umndersize,
Oversize, Fragments, Jabbers, Collisions, Utilizations

Table 12. RMON History

RMON Alarm

To add an alarm and define parameters for it click the Add button. The Alarm Table pop-up will
accept a user-defined index number or you can use the index automatically generated.

£% RMON : Alarm&Event Form : 10.1.1.194 =10 x|
Alarm |Event I Log I .
Syztem Time:
Index I Interval I Y ariahle I SampleType I W alue I Startupdlarm I F F 032351
1 1 etherstatzOctets. 1 delta alue ] Rizifig 1
2 1 etherstatzOctets 2 delta'yalue 0 Rizing 1
3 1 etherstatz0ctets. 3 deltat alue 0 Rizing 1
al 1 etherstatzOctetz delta alue ] Rizifig 1
5 1 etherstatzOctets B delta'/ alue 0 Fizing 1
v 1 etherstatzOctets. 7 delta alue ] Rizifig 1
[efete
fd mdifiy
Refrezh
i I I LI E =it

Figure 122. RMON Alarm Table
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£% Alarm Table : Add X
—larm Entny Startllp

Inde:: IEEEEEI Interyal. |1D Sampling: | abscluteValue 7]

. Threshold W alue
"W ariable: - I
anable IetherStatsDctets J _I'I Rising |55535

Dwrier: Il:lwner Falling ||:|
—Riging Ewvent Falling Ewent

v Activate Rising Event | Index: |24455 v Activate Falling Event Index: |25559

Description: |Hi3ing E vent Description: IFaIIing Event

Cammunity: Ipuh“.: Commurity: Ipuhlin:

Type: II:::g-ann:I-trap j Type: IIng-and-trap j

OF | Cancel |

Figure 123. RMON Alarm Table: Add
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Path: MIBs > RMON - Alarm/Event

Index, Interval, Variable, SampleType, Value, StartupAlarm,
RisingThreshold, FallingThreshold, RisingEvent,
FallingEvent, Owner, Status

RMON Alarm Table
Information

Index, Interval, Variable, Owner, StartUp Sampling,
RMON Alarm : Threshold Value: Rising/Falling,

Add/Modify Parameters Rising Event: Activate/Index/Description/Community/Type
Falling Event: Activate/Index/Description/Community/Type

Table 13. RMON Alarm Table

RMON Event

The Event controls work in a similar fashion. Add or modify an Event control and define its
parameters by clicking the Add or Modify button, the Event Control pop-up menu appears.

£% RMON : Alarm&Event Form: 10.1.1.194 —10] =l
Alaim  Ewent I Log I 5
Syztem Time:

Index | Dregzcription | Type | Cornrmrity | TimeSent | Chwner | Sta I-T:q: 032541

1 Rizing Ewent log-and-trap public 0:00:00.00 Owarer vali

2 Rizing Ewent log-and-trap public 0:00:00.00 Owarer vali

3 Rizing Ewent log-and-trap public 0:00:00.00 Chwner wali

5 Rizing Ewent log-and-trap public 0:00:00.00 Chwner wali

B Rizing Ewent log-and-trap public 0:00:00.00 Chwner wali

7 Rizing Ewent log-and-trap public 19 days, 18:21:00.171  Owner vali #dd
Delete
e edifyy
Refrezh

7 I I LI E mit

Figure 124. RMON Event
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£% RMON : Alarm&Event Form: 10.1.1.194 =0l x|
Bilarm | Ewent Log | ;
| | | | System Tirme:
logEwentindex | loglndex | logTime logD escription - F 032957
7 14614 19 davs, 341:0464  1.361.21.16.1.1.1.4.7 [dekta = 30... [
7 14615 19 daps, 534062 1.361.21.16.1.1.1.4.7 [dekta = 35...
7 14616 19 daps, 3593563  1.361.21.16.1.1.1.4.7 [dekta = 19...
7 14617 19 days, 35935862 1.361.21.16.1.1.1.4.7 [dekta = 14...
7 14618 19 days, 100016 1.361.21.16.1.1.1.4.7 [dekta = 37...
7 14619 19daps, 10:0533..  1.361.21.161.1.1.4.7 [deka=11... #idd
7 14620 19days, 100702, 1.361.21.16.1.1.1.4.7 [dekta = 19... E——
7 14621 19daps, 101315, 1.361.21.16.1.1.1.4.7 (dekta = 20...
7 14622 19daps, 102549 1.361.21.16.1.1.1.4.7 [delta = 60... o
7 14623 19daps, 10:3%:01...  1.361.21.16.1.1.1.4.7 [dekta = 19... I A
7 14624 19 days, 10:45:23..  1.361.21.16.1.1.1.4.7 [dekta = 92... Refiesh
7 14625 19days, 105537, 1.361.21.16.1.1.1.47 [dekta=11... IS
7 14626 19days, 11:04718..  1.361.21.16.1.1.1.4.7 [dekta = 59... < Exit
7 14C7 10 A= 110047200 1201 311111 4 FiAd~lk=- 10 ——
Figure 125. RMON Log
Path: MIBs &> RMON - Alarm/Event
Index, Description, Type, Community, TimeSent,
RMON Alarm Event Table Owner, Status
Information . L
LogEventindex, logindex, logTime, logDescription

Table 14. RMON Alarm Event Table
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802.1P & 802.1Q

802.1P

802.1P Priority Settings

Use the 802.1P side menus to view and set 802.1P port priority as well as GMRP and GARP
settings. The read-only Port Capability Form is accessed as a side menu.

802.1P / 802.1Q ( RFC2674 ) MIBs

1pPriority Group

This group contains the objects for configuring and reporting status of priority-based queuing
mechanisms in a bridge. This includes per-port user priority treatment, mapping of user priority in
frames into internal traffic classes and outbound user priority and access priority.

1pGarp Group

This group contains the objects for configuring and reporting on operation of the Generic Attribute
Registration Protocol (GARP).

1pGmrp Group

This group contains the objects for configuring and reporting on operation of the GARP Multicast
Registration Protocol (GMRP).

Dot1gBase Group

This mandatory group contains the objects, which are applicable to all bridges implementing IEEE
802.1Q virtual LANSs.

The dot1qTp Group

This group contains objects that control the operation and report the status of transparent bridging.
This includes management of the dynamic Filtering Databases for both unicast and multicast
forwarding. This group will be implemented by all bridges that perform destination-address filtering.

The dot1qgStatic Group
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This group contains objects that control static configuration information for transparent bridging. This
includes management of the static entries in the Filtering Databases for both unicast and
multicast forwarding.

The dot1gVlan Group

This group contains objects that control configuration and report status of the Virtual LANs known to a
bridge. This includes management of the statically configured VLANs as well as reporting VLANs
discovered by other means e.g. GVRP. It also controls configuration and reports status of per-port
objects relating to VLANSs and reports traffic statistics. It also provides for management of the VLAN
Learning Constraints.

Table 15.

802.1P Basic Configuration

Set the Traffic Class State (true, false) and GMRP Status.

£% 502.1P Basic Configure ; 10.43.10.8 =0 x|

Device Capabiliiies |48
Refrazh |

Traffic Clazzes State |true

GMRP Status | dizabled [

GetDISMMP : Ok! Bequest Beceive at 03:40:41 F9F.

Figure 126. 802.1P Basic Configuration
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Path: MIBs - 802.1P - Basic Configuration

802.1P Basic Read-only | Device Capabilties

Configuration

Set | Traffic Class Status, GMRP Status

Table 16. 802.1P Basic Configuration

Priority Information Form

Choose the appropriate tab to view information listed by port number:

154



D-View 5.1 User’s Guide

1ol x|
|zer Pricnties To Traffic Clags | Fort Qutbound Access Prionties
Default User Priorities of Each Port | Regenerated Llser Priorities o
Samples
PortMumber I Defaultl zerPriarity | PortHumTrafficClasses | -
1) ] 4 : |
5 0 4 Fiefresh
i S
4 i 4 Set
5 ] 4
B ] 4
7 ] 4
g 0 4
9 a 4
10 0 4
i ] 4
12 1] 4
13 a 4 i
14 a 4
15 0 4
16 0 4
17 ] 4
18 i 4 =|
Port Hurnber 3 Supported Traffic Clazses Mum[1-8] |4
Drefault Lser Prionty [D-?]ID
GetDISNMP : Okl Bequest Receive at 03:42:21 F9.
GetDISHMP : Okl Request. Receive at 03:42:22 F4F.

Figure 127. Priority Information Form

Select the port number and type in the appropriate priority values; click Set to effect the change.
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Path: MIBs - 802.1P - Priority Information Form

Table | PortNumber, DefaultUserPriority,

Default User Priorities of Information | PortNumTrafficClasses
Each Port Set SupportedTrafficClassesNum,
DefaultUserPriority
Table | PortNumber, UserPriority,
Regenerated User Information | RegeneratedUserPriority
Priorities

Set | UserPriority

Table | PortNumber, TrafficClassPriority,

User Priority To Traffic Information | MappedTrafficClass
Class .
Set | MappedTrafficClass
qut putbound Access Ta_b le PortNumber, RegenerateUserPriority
Priority Information

Table 17. Priority Information Form

Port Capability

The Port Capability window (accessed as a side menu from 802.1P submenu) is read-only and
lists Port Capabilities Entry Messages listed by port number.
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ﬂfﬁ? Port Capability Fom : 1043 10.8 _ -0} x|
Forttumber | datl dF‘u:urtEapaI:niIities -

: 05 |

3 05 Samples

3 05 — -
4 05 . Fefiesh
a] 05

B 05

i 05

a 05 e

3 05

10 05

11 05

= 05

13 05

14 05 lI

GetDISKMP : Okl Bequest. Beceive at 03:43:37 T <F.

Figure 128. Ports Capability
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Path: MIBs - 802.1P - Ports Capability

Table Information PortNumber, dot1dPortCapabilities

Table 18. Ports Capability

GMRP

The GMRP Form allows you to enable GMRP for a selected port. To enable GMRP for a given port,
highlight to select, choose Enable from the pull-down menu and click Set.

Path: MIBs - 802.1P > GMRP

GMRP Table Information PortNumber, Status, GmrpFailed, GmrpLastPduOrign

Table 19. GMRP Table

GARP

GARP settings are expressed in Centi-seconds (hundredths of a second) for each port.
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: (=
FortMurnber | GARPJoinTime | GARPLeaveTime | GARPLeavedlTime | Y
i 20 B0 1000 e
2 20 &0 1000 "

3 20 il 1000

4 20 E0 1000

5 20 il 1000 ﬂl
= 20 &0 1000

7 20 B0 1000 Set
] 20 E0 1000

q 20 il 1000

10 20 g0 1000

11 20 E0 1000

12 = 1000

13 20 £ 1000

14 20 B0 1000

15 20 Bl 1000

16 20 E0 1000

17 20 =il 1000

18 20 &0 1000 e
19 20 il 1000

20 20 E0 1000

21 20 BD 1000 =]
GARP Jain Time [0 2147483647] |2D Centizeconds

GARF Leave Time  [0...2147483647) |ED Centizeconds

GARF Leave &l Time [0....2147483647] |1DEID Centizeconds

GetDISMMP - Okl Request Receive at 03:44:47 T3

Figure 129. GARP Form
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Path: MIBs - 802.1P > GARP

PortNumber, GarpJoinTime, GarpLeaveTime,

GARP Table Information GarpLeaveAllTime

Set GarpJoinTime, GarpLeaveTime, GarpLeaveAllTime

Table 20. GARP Table

802.1Q

802.1Q Ports Information

Configure VLANSs settings for the selected device in the VLAN Ports Information side menu.
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£% VLAN Port Infomation Form ; 10.43.108 . =10l x|
Parttumber | PartyLARID | AcceptableFrameT vpes I IngrezzFilkenng I GYRPStatuz I GYRPF =

1 1 admita false disabled 0 24

2 1 adrit|l falze dizabled ] Samples
3 1 admitll falze dizabled ]

4 1 admitdl falze dizabled ]

4] 1 adrmitall falze dizabled n Eefrezh
G 1 adrmitl falze dizabled ]

i 1 admital falze dizahbled 1] St
a 1 admitll falze dizabled ]

0|

10 1 admital falze dizabled 1]

11 1 adrmitll falze dizabled ]

12 1 admitdl falze dizabled ]

13 1 admital falze dizabled 1]

14 1 adrit|l falze dizabled ] e

15 1 admitl falze dizabled 1]

16 1 admitdl falze dizabled ]

17 1 admitéll falze dizabled ]

14 1 adritdl falze dizabled 1]

1 EI 1 admitl falze dizabled 1 _ILI

4 | 3

Part WLAN 1D |1 Acceptable Frame Types |adl‘ﬂib’-"-|| LI

Ingress Filtering | false ~| GYRP Status [disabled  ~]

GetDISMMP : Ok! Bequest: Beceive at 03:45:54 F 4.

Figure 130. 802.1Q VLAN Port Information Form
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Path: MIBs - 802.1Q - 802.1Q Bridge - Ports Information

PortNumber, PortVianiD,

Table Information AcceptableFrameTypes, IngressFiltering,

GvrpStatus, GvrpFailedRegistrations,
VLAN Ports S
Information GvrpLastPduOrigin
Form
Set PortVlanID, AcceptableFrameTypes,

IngressFiltering, GvrpStatus

Table 21. Ports Information

802.1Q Learning Constraint Table
Set Default VLAN Constraint Value and Default Constraint Type.

To add a new listing to the Constraint Table or Modify and existing one, highlight it and select
Status and Type from the pull-down menus. Click the Add/Update button effect the changes.

Path: MIBs - 802.1Q - 802.1Q Bridge - Learning Constraint Table

Table Information ConstraintVlanID, ConstraintSet, Type, Status
Learning i
Constraint | get DefauItVIanConstra!ntSet,
Table DefaultVlanConstraintType
Configure ConstraintVlanID, Type, ConstraintSet, Status

Table 22. Learning Constraint Table
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802.1Q VLAN

The Basic VLAN Configuration Form presents in two tables to display VLAN Static and VLAN
Current information.

Form : 1001 ;lgl x|

WLAN Static Table |\-fLAN Current Tablel

1
- Samples
WLAK (D I WLAN M ame | Egress Parts | Forbidden Egress Parts | Untagged Ports | &
1 DEF&ULT... FFFFFFCO 00000000 FFFFFECO £
Set
Add
Delete |
4| [ H

Mext Free Local WLAN Index (4095

WLAN Information | Egress Portsl Forbidden Portsl Untagged Portsl

WLAN |0 I YLAN Mame I
Status I 'l

Gek:DISNMP ; Ok! Request Receive at 10:31:15 £ 5.

Figure 131. 802.1Q VLAN
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Path: MIBs - 802.1Q - 802.1Q VLAN

VLAN ID, VLAN Name, Egress Ports,

VLAN | Table Information Forbidden Egress Ports

Static
Table | set VLAN Information, Egress Ports, Forbidden Ports,

Untagged Ports

VLAN ID, VLAN Name, Egress Ports,

VLAN | Table information Forbidden Egress Ports, Untagged Ports, Status

Current
Table Set Egress Ports, Untagged Ports

Table 23. 802.1Q VLAN

802.1Q Forwarding/Filtering

Forwarding and Filtering information is presented in four separate menus. The menus listed here
appear as tabs in the Forwarding/Filtering Form.
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Path: MIBs - 802.1Q - Forwarding/Filtering Form

Unicast
Forwarding Table Information | Fdb |d, FdbMacAddress, PortNumber, Status
Info
. VLAN ID, GroupAddres, EgressPorts,

Tp Group Table Information GMRPLearmntPorts
Destination
Forwarded Configure | EgressPorts, GMRPLearntPorts
Multcast Table information | VLAN ID, AllPorts, StaticPorts, ForbiddenPorts
Forwarding -
Info Confiqure AllForwardedPorts, AllStaticPorts,

9ure | AllForbiddenPorts
Forward Table Information VLAN ID, UnregisteredPorts,

Unregistered
Info

Unregistered,StaticPorts

Configure

UnregisteredPorts, UnregisteredStaticPorts,
UnregisteredForbiddenPorts

Table 24. Forwarding/Filtering Form
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E‘f::: Tnicazt®ulticast Static Filter Table : 10 42.10.3

Unizast Info | Multizast Info I

Index | Unicastdddress | ReceivePort | PorttsUnicastillowedT oGoTo | Status

1 80000000 R |
1 000000000002 O 40000000 f—
1 000000000003 O 20000000 D,
WD [i
MAC Address [00000000000T Status | permanent =]

—Allow To Ga To Port

i me I R el S s S s i
| ek e T e A i e i e e T e
ity e ags e i I Ed 152

GetDISNMP : Okl Request Receive at 03:48:19 FF.

=10] x|
-

Samples

Refrezh

Set

Figure 132. Unicast Multicast Static Filter Table
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Path: MIBs = 802.1Q - Unicast/Multicast Static Filter Table

UnicastAddress, ReceivePort,

Table Information PortsUnicastAllowedToGoTo, Status

Unicast Info
VID, MAC Address, Status,

Configure | Ajlow To Go To Ports (select ports)

MAC Address, Receive Port, Egress Port,

VLAN Table information | o i4i0 1 Ports, Status
Current VID, MAC Add S

, ress, Status,
Table Configure

Egress Ports, Forbidden Ports (select ports)

Table 25. Unicast/Multicast Static Filter Table

Traffic Statistics

Traffic Statistics

Port traffic statistics for selected devices are viewed by highlighting the chosen port and clicking
on the Statistics Info button. A new menu pops up displaying port statistics in line graph form.
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Port VLAN Statistics

£% 802.10 Ports ¥LAN Statistic Form: 10.1.1.153

Portl e | YLAMNIndex | InFrames | QutFrames | |nDizcards | |nDverflowFrames | OutdverflowFrames | P

1] | i
. Times——
Statiztic: 01ata | Received/Trazmitted Frames | ErrorFramesI me
Count
Poit Index 0 W0EAM [ndex 0 I-“:| j
[nterval
I ame W alue Delta Hate Peal: Peak, Q...
|1 "l 5
InFrames 0 0 0 0 E-43.41 PM =
QOutFramesz 0 a a 1] E:42:47 P
InDizcards 0 0 0 1] E:42:47 P [~ 30 Chart
InDverflowFrames 0 a a 1] B:42:47 PM
OutDverflowFrames il 0 0 0 B:43:41 PM Stop |
PortlnOverflowDizcards 0 a a 1] E:42:471 PM

Start |

GetDISMMP : Ok! Request: Receive at 06:43:47 P,

Figure 133.
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Layer 3 Utilities

Layer 3 Utilities

To access Layer 3 utilities located under the MIBs proceed as follows: MIBs - 802.1Q - Layer 3
Utilities.

IP Forwarding

IP Forward (RFC 2096) MIB

The MIB consists of two tables and two global objects.
1. The object ipForwardNumber indicates the number of current routes. This is primarily to
avoid having to read the table in order to determine this number.
2. The ipForwardTable updates the RFC 1213 ipRouteTable to display multipath IP Routes.
This is in turn obsoleted by the ipCidrRouteTable.
3. The ipCidrRouteTable updates the RFC 1213 ipRouteTable to display multipath IP Routes
having the same network number but differing network masks.

Table 26.
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&5 IP Forwarding - 10.48.46.18 =101 x|
CIDR Table | IF Farward Table |
n
CidrR outeMumber
Samplez
CidriFouteDeztip | Foutetdaszk | FouteT ypelfService | CidrBouteMextHop | CidiF outelfindex | |
........ T

ol

I—
b etricd I

I—
b etrich I

Ctatus |*5"'3ti“"E j'

CidRousDestp | RouteMask |

FouteT ypelfService I— CidrRouteM extHop |

CidRouslfindess | RouteTupe fatiner B
Fratocal I— Age |

Routelnfo | MestHopa S urm I

P etric P etric2 Metric3 I—

Dizable0lD= |

[Get Okl RequestipCidtRouteEntry Received at 03:50:46 FF.

Figure134. IP Forwarding
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Path: MIBs - Layer 3 utilities > IP Forwarding

CidrRouteNumber, CidrRouteDestlp, RouteMask,
RouteTypeOfService, CidrRouteNextHop,
CidrRoutelndex, RouteType, Protocol, Age,
Routelnfo, NextHopASNum, Metric 1, Metric 2, Metric
3, Metric 4, Metric 5, Status

Table
Information

CIDR Table CidrRouteNumber, CidrRouteDestlp, RouteMask,

RouteTypeOfService, CidrRouteNextHop,
Configure | CidrRoutelndex, RouteType, Protocol, Age,
Routelnfo, NextHopASNum,

Metric 1, Metric 2, Metric 3, Metric 4, Metric 5, Status

IpForwardEntriesNumber, ipForwardMask,
Table | ipForwardindex, ipForwardNextHopAS,

information | ipForwardType,

IP Forward IpForwardInfo

Table IpForwardEntriesNumber, ipForwardMask,
ipForwardIndex, ipForwardNextHopAS,
ipForwardType,

IpForwardInfo

Configure

Table 27. IP Forwarding
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RIP 2

RIP2 (RFC 1724) MIB

The RIP-2 MIB contains global counters, useful for detecting the deleterious effects of RIP
incompatibilities; two "interfaces" tables, which contains interface-specific statistics and configuration
information; and an optional "peer" table, containing information that may be helpful in debugging
neighbor relationships. Like the protocol itself, this MIB takes great care to preserve compatibility with
RIP-1 systems and controls for monitoring and controlling system interactions.

Global Counters

These counters are intended to facilitate debugging quickly changing routes or failing neighbors

Implementation of this Group is Optional

This group provides information about active peer relationships intended to assist in debugging. An
active peer is a router from which a valid RIP updated has been heard in the last 180 seconds.

Table 28. RIP 2 Form

Path: MIBs - Layer 3 utilities > RIP 2

GlobalRouteChanges,
Read-only | GlobalQueriesResponse
Subnet Information | SubnetlPAddress, NumOfTriggeredRIPStates,
Information Status
Set | Subnet IP Address, Status
Subnet Read-only | |5 \ yyres
Configuration Information
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AuthenticationType, AuthenticationKey,
Set | InterfaceSends, AcceptedRIPVersion,
DefaultMetric, Status, InterfaceSourceAddress

SrclpAddress, PeerDomainReceivedPackets,
Table Information | sysUpTimeOfLastUpdate, VersionNumber,
RcvBadPackets, RcvBadRoutes

Routing Peer
Information

Table 29. RIP 2

OSPF

OSPF (RFC 1850)
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OSPF is a powerful routing protocol, equipped with features to handle virtually any configuration
requirement that might reasonably be found within an Autonomous System. With this power comes a
fair degree of complexity, which the sheer number of objects in the MIB will attest to. Care has
therefore been taken, in constructing this MIB, to define default values for virtually every object, to
minimize the amount of parameterization required in the typical case. That default configuration is as
follows: Given the following assumptions:

-IP has already been configured

-The if Table has already been configured

-if Speed is estimated by the interface drivers

-The OSPF Process automatically discovers all IP

-Interfaces and creates corresponding OSPF Interfaces

-The TOS 0 metrics are autonomously derived from if Speed

-The OSPF Process automatically creates the Areas required for the Interfaces

The simplest configuration of an OSPF process requires that:
« The OSPF Process is enabled.
e Area Data Structure and Area Stub Metric Table

« The Area Data Structure describes the OSPF Areas that the router participates in. The Area
Stub Metric Table describes the metrics advertised into a stub area by the default router(s).

Link State Database and External Link State Database

The Link State Database is provided primarily to provide detailed information for network debugging.

Address Table and Host Tables

The Address Range Table and Host Table are provided to view configured Network Summary and
Host Route information.

Interface and Interface Metric Tables

The Interface Table and the Interface Metric Table together describe the various IP interfaces to
OSPF. The metrics are placed in separate tables in order to simplify dealing with multiple types of
service, and to provide flexibility in the event that the IP TOS definition is changed in the future. A
Default Value specification is supplied for the TOS 0 (default) metric.

Virtual Interface Table

Likewise, the Virtual Interface Table describes virtual links to the OSPF Process.
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Neighbor and Virtual Neighbor Tables

The Neighbor Table and the Virtual Neighbor Table describe the neighbors to the OSPF Process.

OSPF Traps

OSPF is an event driven routing protocol, where an event can be a change in an OSPF interface's
link-level status, the expiration of an OSPF timer or the reception of an OSPF protocol packet. Many
of the actions that OSPF takes as a result of these events will result in a change of the routing
topology. As routing topologies become large and complex it is often difficult to locate the source of a
topology change or unpredicted routing path by polling a large number or routers. Another approach

is to notify a network manager of potentially critical OSPF events with SNMP traps.

Table 30.

5‘& OSFF- 10431028

Routerld I I I I

|ena|:|leu:| "’I
Ii

AdmiristrativeStatus
OSPF YerzionM um
treaBorderFioterStatus |
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ExterrlzaCourt |

ExternlzaChecksum

TO5 Support

=101 x|

MumOforiginatesM ewl zas

FxMewlzas

Extlzdblimit-1..2747453647] |-1

—
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Bithd 3zl Otk Lilticast

E «itMwartlmwl ntereal

[0..2147483647]
DemandR outingS upport

Refrezh

IGet:I'In:u such OID dn field (FouterId)! RFeguest:O3PF General Fecedved at03:52:51 TF4F.

Figure 135. OSPF General Information
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Path: MIBs > Layer 3 utilities > OSPF - OSPF General

NumOforiginatesLsas, OSPF VersionNum, RxNewLsas,

Read-only AreaBorderRouterStatus, ExternLsaCount, ExternLsaChecksum

Routerld, Support Service Type, ASBorderRouterStatus,
Set ExtLsdbLimit, ASBorderRouterStatus, BitMaskOfMulticast,
ExitOverflowInterval, DemandRoutingSupport

Table 31. OSPF General Information
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Path: MIBs - Layer 3 utilities > OSPF - OSPF Area Information

GlobalRouteChanges, GlobalQueriesResponse
SubnetlPAddress, NumOfTriggeredRIPStates,
Status

Read-only
Information
Area Table

Areald, Type
Set | Area Summary, Area Status,
ImportASExternLsa

Read-only

Information Stub Area, Type Of Service

Stub Area Table
Set | Metric, Metric Type, Status

Read-only | AggreagateArealD, AggregateNet,
Area Aggregate Information | AggregateMask

Table

Set | AggregateEffect, LsdbType, AggregateStatus
Area Range AreaRangeAreald, AreaRangeNet,
Table 9 Set | AreaRangeMask, AreaRangeEffect,

AreaRangeStatus

Table 32. OSPF Area Information
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Path: MIBs - Layer 3 utilities > OSPF - OSPF Lsdb Form

Link State
Database

Table Information | SequenceNum, Age, Checksum,

LsdbAreald, Type, LinkStatlD, RouterlD,

Advertisement

Ext Link State
Database

Table Information | SequenceNum, Age, Checksum,

LsdbType, LinkStatelD, RouterID,

Advertisement

OSPF Host Table

Table 33. OSPF Lsdb Form

Path: MIBs - Layer 3 utilities > OSPF - OSPF Host Table Form

Table Information

HostlpAddress, TypeOfService, Metric, Status, HostArealD

Set

HostlpAddress, TypeOfService, Metric, Status

Table 34. OSPF Host Table Form
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Path: MIBs - Layer 3 utilities > OSPF - OSPF Interface

Table Read-only

IflpAddress, AddressLesslinterface

Information
Interface Type, Priority, Status, _
Table ArealdOfinterfaceConnected, TransitDelay,
Set AuthenticationKey, Retransinterval,
IfMulticastForwarding, Helpinterval,
Administrative Status, RouterDeadlnterval,
IfDemand, Pollinterval, Authentication Type
Interf Table/Read-only
I\;Ile(:rica:ce Information | [pAddress, AddressLesslInterface, TypeOfService
Table .
Set | MetricValue, Status
_ Table Read-only
Virtual Information | Areald, NeighborlD
Interface
Table Set TransitDelay, Hellointerval, Retransinterval,

RtrDeadInterval,

Table 35. OSPF Interface
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OSPF Neighbor Form

Sﬁ COEPF Neighbor Fomn 0 1042 108
NeighborT able | itual Neighbor Table |

=101 x|
0

Samples

Ip&ddress I Addresslesslndes I MbrFouteld I Options I Priarity I FielationzhipState

|

|ptiddress |

Addressbessindes |

Refresh |

Dizable0IDs |

2
Pricrity |-|
[0-255)
Status |active 'l

[GetOk! Eequest: Neighbor Message Received at03.54.28 F=F.

Figure 136. OSPF Neighbor Form

Path: MIBs > Layer 3 utilities > OSPF - OSPF Neighbor

Table/Read-only

Information | IpAddress, AddressLessIndex

Neighbor
Table

Set | Priority, Status
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Vir.tual Table Information TransitAreaID, NbrRouterld, VirtugINbrIpAddr,
Neighbor Options, State, Events, RetransmissionQueuelen,
Table HelloSuppressed

Table 36. OSPF Neighbor

Path: MIBs - Layer 3 utilities > OSPF - OSPF Trap Form

Table Information OspfSetTrap, ConfigErrorType, PacketType, PacketSrc

OSPF Trap Events

Table 37. OSPF Trap Form
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IP Mroute

IP MRoute (RFC 2932) MIB

This MIB module contains one scalar and five tables. The tables are:

6. The IP Multicast Route Table containing multicast routing information for IP data grams sent
by particular sources to the IP multicast groups known to a router.

7. The IP Multicast Routing Next Hop Table containing information on the next-hops for the
routing IP multicast data grams. Each entry is one of a list of next-hops on outgoing
interfaces for particular sources sending to a particular multicast group address.

8. The IP Multicast Routing Interface Table containing multicast routing information specific to

interfaces.

9. The IP Multicast Scope Boundary Table containing the boundaries configured for multicast
scopes.

10. The IP Multicast Scope Name Table containing human-readable names of multicast scope.

Table 38.

182



D-View 5.1 User’s Guide

iﬁ IPMEoutForm : 1043 108 ~ =18l
IPM Foute Table I Mext Hop T able | Interface Table I BoundamEntry Table I
o
MulticaztRouteEnable Ienabled :] Sel Samples

Eroup I Source I Sourcekd azk I | pstreamieighbor I Inlfindex I UpTime I ExpirTim

StatisticalChart |

4 | i

[GetOk! RequestIFM Ronte Received at 03:55:44 TF4F, 2

Figure 137. IPMroute Form

Path: MIBs > Layer 3 utilities = IP Mroute

IPMRoute
Table

Group, Source, Source Mask, Upstream
Neighbor, ReceivedlpDatagramsSource,
Table Information | UpTime, ExpiryTime, RoutePkts,
DiferentSourcePackets,
NumOfQOctetsinlPDatagrams, RouterProtocol

Set | MulticastRouteEnable
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Next Hop
Table

Table Information

NextHopGroup, NextHopSource,
NextHopSoureMask, NextHopIndex,
NextHopAddress, State, UpTime, ExpiryTime,
ClosestMemeberHops, Protocol, ForwardPkts

Interface Table

Table Read-only

BoundaryEntry
Table

Information Index
Set | TTL Threshold, Interface Protocol
Table Read-o_nly Ifindex, Address, AddressMask, Status
Information
Set | Status

Table 39. IP Mroute
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DVMRP

DVMRP

DVMRP is an "interior gateway protocol"; suitable for use within an autonomous system, but not
between different autonomous systems. DVMRP is not currently developed for use in routing non-
multicast data grams, so a router that routes both multicast and unicast data grams must run two
separate routing processes. DVMRP is designed to be easily extensible and could be extended to
route unicast data grams.

DVMRP was developed to experiment with the algorithms in RIP was used as the starting point for
the development because an implementation was available and distance vector algorithms are
simple, as compared to link-state algorithms. In addition, to allow experiments to traverse networks
that do not support multicasting, a mechanism called "tunneling" was developed.

The multicast-forwarding algorithm requires the building of trees based on routing information. This
tree building needs more state information than RIP is designed to provide, so DVMRP is much more
complicated in some places than RIP. A link-state algorithm, which already maintains much of the
state needed, might prove a better basis for Internet multicasting routing and forwarding.

DVMRP differs from RIP in one very important way. RIP thinks in terms of routing and forwarding data
grams to a particular destination. The purpose of DVMRP is to keep track of the return

paths to the source of multicast data grams. To make explanation of DVMRP more consistent with
RIP, the word "destination" is used instead of the more proper "source", but the reader must
remember that data grams are not forwarded to these destinations, but originate from them.

Table 40.
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Figure 138. DVMRP
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Path: MIBs > Layer 3 utilities > DVMRP

General
Info Table

Read-only Information

DVMRPVersion, DVMRPGenerationld,
NumberOfRoutes, ReachableRoutes

Table 41. DVMRP
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PIM

PIM MIB

This MIB module contains one scalar and eight tables.
The tables contained in this MIB are:
1. The PIM Interface Table contains one row for each of the router's PIM interfaces.
2. The PIM Neighbor Table contains one row for each of the router's PIM neighbors.
3. The PIM IP Multicast Route Table contains one row for each multicast routing entry whose
incoming interface is running PIM.
4. The PIM Next Hop Table which contains one row for each outgoing interface list entry in the
multicast routing table whose interface is running PIM, and whose state is pruned.
5. The (deprecated) PIM RP Table contains the PIM (version 1) information for IP multicast
groups which is common to all RPs of a group.
6. The PIM RP-Set Table contains the PIM (version 2) information for sets of candidate
Rendezvous Points (RPs) for IP multicast group addresses with particular address prefixes.
7. The PIM Candidate-RP Table contains the IP multicast groups for which the local router is to
advertise itself as a Candidate-RP. If this table is empty, then the local router advertises itself
as a Candidate-RP for all groups.
8. The PIM Component Table contains one row for each of the PIM domains to which the router
is connected.

Table 42.
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gﬁ FIM Form; 10,1679 36 i ||:|| 1'
Fitd Interface Table | Neighl:u:ur Tal:ulel Pl Component InfDI
[
PirmdoinPrunelntereal [Sec] IED Eet | Samples
= Set
[ridex | [Paddress | M ethd azk | tode | [ezignedH outer | Hellalnteryal | Statuz | i
167936 [ 255.0.0.0 01679, 36 notlinService | B
10.16.79. 36 0.0.0 10.16.79.35 30 [ hatinSer Rafiash
Dizable0IDs
| | I
[fl e |25|3 Hellolnteral[1-65525]
|3EI
IPAddress |'| 0.16.79.36
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Figure 139. PIM
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Path: MIBs - Layer 3 utilities > PIM - PIM Info

Table | RPGroupAddress, RPAddress, RPState,
RP Table Information | RPStateTimer, RPLastChange
Set | RPRowStatus
RoSetTable Table | RPSetGorupAddress, RPSetGrouMask,

P Information | RPSetAddress, RPSetHoldTime, RPSetExpiryTime
CandidateR Inf Ti.ble CandidateRPGroupAddress, CandidateRPGroupMask
PEntryTabl ntormation
e Set | RowStatus

Table 43. PIM Information
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Path: MIBs > Layer 3 utilities > PIM - Rendezvous Points Info

Table/Read-only | 1pagaress, NetMask
PIM Interface nformation
Table PimJoinPrunelnterval, Ifindex,
Set | JoinPrunelnterval, Candidate Bootstrap Router,
Hellolnterval, Mode, Status
Neighbor Table Table Information I\N/l((a)ldggborAddress, Ifindex, UpTime, ExpiryTime,
Table/Read-only | o o ntindex
PIM Component Information P
Info
Set | Status, CRPHoldTime

Table 44. Rendezvous Points Information

SNMPv3 Configuration

Use the SNMPv3 menu to configure SNMPv3 security settings and new user setup. Choose
SNMPv1, SNMPv2 or SNMPv3 as appropriate in the SNMP Version entry field.
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£% SNMP ¥3 Configuration =13l x|

P Port SMMP Protocol Wersion
: ort:
I Jio11s4 % 181 (r‘ SNMPv1  ( SNMPv2c (& SNMPy3
Security Mame: InD.-'l'-.uthLl 2ar j Context Engine [0 ||:|-| 0000al d4 St
Auth Pasgward: I.-’-'-.uthF'asswu:urd Priv Password: IF'rivF'asswu:urd Test
Auth Protocal; INEINE j Friv Protocal; INEINE j MPD
Contest M arne: Ipub“,: Security Lewvel: I MaduthM aPriv j TARGET
Wit Community Sting : [priyate Tirne-cut: |2 Beties: |2
I I /4' U5
/ YACH
Use buttons to access pop-up menu Exi
| 4

Figure 140. SNMPv3 - SNMP Protocol Preferences
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Path: MIBs &> SNMPv3

System Description, System Object ID, Sytem
Table/Read-only Information | Uptime, System Contact, System Name, System
Location

IP Address, Port Number, Security Name, Context
Engine ID, Auth Password, Priv Password, Auth
Protocol, Priv Protocol, Contact Name, Security
Level, Write Community String, Time-out, Retries

User Defined Parameters

Table 45. SNMPv3 — SNMP Protocol Preferences
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SNMP Protocol Settings Pop-up Menus

£% MPD (RFC2572) - 0] x|
koS ecuntpbd odels | Irvalidid zgs | UnknownPDUHandlers |
Note: SNMP protocol preferences pop-up menus are
accessed by clicking the buttons on the right side of the
SNMP Configuration menu. Use these menus exactly as Refrezh
menus used in previous examples.
Sef
Claze
SMMP @ SMMP request timed out! e

Figure 141. MPD (RFC 2572)
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Path: MIBs - SNMPv3 (click MPD button)

MPD (RFC 2572) Table SecurityModels, InvalidMsgs,

UnknownPDUHandlers

Table 46. MPD (RFC 2572) SNMP Parameter Pop-up Menu

Path:

MIBs - SNMPv3 (click Target button)

AddEntry_Table

AddrName, AddrTDomain, AddrTAddress, AddrTimeout,
AddrRetryCount, AddrTagList, AddrParams,
AddrStorageType, AddrRowStatus

ParamsEntry_Table

ParamsName, ParamsMPModel, ParamsSecurityModel,
ParamsSecurityName, ParamsSecurityLevel,

ParamsStorageType, ParamsRowStatus

Table 47. Target (RFC 2573) SNMP Parameter Pop-up Menu

Path: MIBs > SNMPv3 (click USM button)

Stats_Table

UnsupportedSecLevels, NotinTimeWindows,

UnknownUserNames, UnknownEnginelDs, WrongDigests,
DecryptionErrors

UserEntry_Table

EnginelD, Name, SecurityName, CloneForm, AuthProtocol,
AuthKeyChange, OwnAuthKeyChange, PrivChange,

PrivKeyChange, OwnPrivKeyChange, Public, StorageType,
Status

Table 48. USM (RFC 2574) SNMP Parameter Pop-up Menu
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Path: MIBs - SNMPv3 (click VACM button)

ContextEntry_Table vacmContextEntryName

SecurityName, SecurityModel, GroupName,
SecurityToGroupEntry_Table | SecurityToGroupStorageType,
SecurityToGroupStatus

ContextPrefix, SecurityLevel, SecurityModel,
Entry_Table ContextName, ReadViewName, WriteViewName,
NotifyViewName, StroageType, Status

Table 49. VACM (RFC 2575) SNMP Parameter Pop-up Menu

196



D-View 5.1 User’s Guide

INTERNET TOOLS

This chapter explains items in the “Tools” drop-down menu in the order of the descending menu
items.

DIAP

D-View includes standard network management utilities such as TFTP and Ping Test user
convenience. D-View 5. 1 also includes D-Link’s proprietary administration utility DIAP. DIAP
allows the user to have limited administrative access to D-Link broadband devices such as ADSL
and ISDN routers, ADSL modems and Wireless routers. This tool can be used to assign IP settings
to such devices. DIAP will automatically discover all DIAP enabled devices and display IP settings
and MAC information in a separate window.
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£% DIAP Configuration - 10| x|
MAC Address | Module Mame | IP Address | Nettdask |
QOFFCR000007 C/L-B000 10.1.40.88 205.0.0.0
Q00550200007 Cw/L-B000 10.47.76.5 200.255.255.0
Q050BAQZBCOB DI-1162 10.254.254. 254 2a0.0.0.0
Q0s0BAQZEBEBFE DI-1162 10.21.97.34 2a5.0.0.0 Sef
Q050BAQD308C DI-1162 10.47.92.1 2a5.0.0.0 -
0024E 40 7F55F Cw/L-B000 10.48.22.133 2a5.0.0.0
QOFFSO0EB40FF Cw/L-B000 10.48.22.53 2a5.0.0.0
Cloze

MaLC Address I IFP &ddress I
todule Mame I MHethd azk I

Faszwaord I

Figure 142. DIAP
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TFTP

The Trivial File Transfer Protocol server can be activated under the Tools heading of the Main
Menu. The TFTP server is active upon launch and can transfer files located on the host system to
any SNMP device. File transfer information is displayed in the TFTP Server window. This
information includes the IP address of the file recipient, the type and name of the file transferred
and the status of the transfer. Error messages appear in the bottom field display.

=10l ]

Mame D View b anager IP Address 110.25.7.100 T
1]
Opened  [F4F 04:03:11 Action Session |0 Total
[ndex | Action P | Type | TFTF File Mame | Statusg
[Clear
Cloze

&bt |

Figure 143. TFTP Server
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BOOTP Server

Use the BOOTP server window to set up BOOTP service for BOOTP enabled devices. This utility is
similar to the TFTP server except it does not require that the host system or D-View be running at
the time of the transfer. D-View can assign other servers on the network to act as BOOTP servers

or it may use the host system as the server.

'. ) BOOTP TFTP Server H WEsEa
T | ECEiVEd %530
|

Add | Deletel Mu:udif_l,ll Save | Cloze | Cowunt I MAC Address

| TETRIP | TFTP File Marme

[+ Enable Server

Client bMAC Address | Client IF

| f (L |

Figure 144. BOOTP Server
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PING Test

The PING Test utility uses this standard test for connectivity. This tests connectivity from the D-
View host to the tested device. Type the IP address of the device you want to Ping, You may also
define the Data Length, Interval, Time Out and Iteration.

-ioix

IP Address Data Length ||:| tart
| -I -I -I [I:I ------- 255] L
Interval Ig Time Out |5 [teration |-| Claze
(1.....10] [1....10] (1.....99909) e
Mo, | IF Addresz | Statug

Figure 145. PING Test
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ADVANCED MANAGEMENT

This chapter explains how to use trap management functions found under the System drop-
down menu. It is organized in the order of the descending menu items. It explains how to access
the Trap Editor, how to edit a TRF file, how to control and view the trap log, and how to change
SMTP trap settings.

This chapter then explains how to add plug-in utilities.

The end of this chapter describes how to use the Account administration utilities to monitor and
analyze client devices and maintain client records. It is organized in the order of the descending
menu items under the Account drop-down menu.

Trap Management

Trap Editor

Use the Trap Editor to modify MIB object names for modules and devices on the network. Select
the device/module from the list in the top panel. MIB objects are indexed according to class. Click
on the index number to view that object class group. To change the alias name of a single object,
double click it or highlight it and click on the Modify icon just above the object list. Use the
Change Alias Name pop up window to modify the object alias name.
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£% Trap Editor - 0] x|
%
Madule | oD |
DFE-2600 Az 3B T1.41.171.10.8.1
DHS-1020 3003 B1.41.171.11.4010.2
Index I - El
1 — -
9 Object | Type | Aliaz Name |
3 gtk ConfigarpGrplndes INTEGER qraup000
4 stk ConfigarpSenalt um INTEGER zenal
] gtk CaonfigarpT ype INTEGER graup type
5 | | stkConfigGrpStatus INTEGER graup statusg
¥
2 hd
Description : Option Data [ vale |
The krap is sent whenever a group is added or removed
From the stackable hub
|Messages | i

Figure 146.
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Clear Trap Alerts

To clear the trap alerts from the scrolling message panel (Trap tab) at the bottom of the main
menu, under System go to Trap Management and left click on Clear.

Sort Trap Alerts

To change the order of presentation of the trap alerts, under System go to Trap Management then
to Sort By and left click on your choice of Time (default), Received From or Trap Message (type).

Trap Type Properties

Trap alerts can be color coded by type to make them easier to distinguish in the list. Open the
Trap Type Properties pop-up window to edit the font and background color of the most urgent
trap types.
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£% Trap Type Froperties x|
Font Color Backaround Color

el | |
T s
T e

Figure 147.

Trap View Filter Settings

Use the Trap View Filter Setting pop up window to limit both the device from which trap alerts are
listed and the type of traps listed. Type the IP address of any device you want to designate for trap

viewing and click the Add button. Highlight a device in the list and click Remove to remove that
device from the trap list.
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The OIDs tab allows you to limit traps to specific OIDs. Specify OIDs to view by typing in the OID
and clicking Add. To remove an OID from the list, highlight it and click Remove.

£% Trap Yiew Filter Setting x|

P Addres
MNew P Address
HEEN @@
—Filtered IP &ddres
Femove
Ok Cancel

Figure 148.
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How to Edit a TRF File
=101 x|
TRAP_XODULE DFE-2600 { ZI
CBIECT_ID { 13614117110 8.1} Module | D_|D [
INSTANCE 1 { | DFE-2600 Lz0.361.41.171.10.81
CBIECT { sthConfiglrpGrpindes , INTEGER, ¢qroupd00s } (BHSHR0_ s03B141171.11401.2
OBJECT { stkConfigGrpSerialfium , INTEGER, <serial: }
OBJECT { sthConfigbrpType . IN ;
SYNTAL {
other, 1, Inden | « gl
oo, = e ——
y 3 stk ConfigGrpGrplndex INTEGER groupD00
dualspeed-16-poct, 4, 4\ tConfigGrmpSerialNum INTEGER serial
dualspeed-24-port, §, 5 stkConfigGpType INTEGER group type
} [ —| | stkConfigGrpStatus INTEGER group status
} 7 -
OBJECT { stkConfigbrpStatus | INTEGER, ¢group ztatus: 2 =
SYNTAL { Drescription : Dption Data | Yalue |
Dthe;’ L The trap is sent whenever a group is added or removed
ggwn '3 From the stackable hub
}
H
DESCRIPTION {
The trap 1z sent whensver a group iz added or removed from the st
} Messages| 4

Figure 149.

Note: Before editing a TRF file, you need to compile the primary module’s MIB files and view
their trap entires, type, and value to know how to edit the module’s TRF file.
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<Install Directory>\5.1\Conf\Trap\ gives the path for a TRF file. TRF files that are .txt files are
composed with the following syntax and parameters:

1. TRAP_ MODULE <Module Name>

At the beginning of the TRF file, define which device is associated with the file. The <Module
Name> parameter is the device name.

2. OBJECT_ID {<Module’s OID>}
Define this device’s OID number. <Module’s OID> parameter is this device’s OID number.

3. INSTANCE <Index>

Define the trap group index number of this device. <Index> is the trap group number of this
device.

4. OBJECT {<trap’s original name>,<trap type>,<trap’s alias name>,...... }

Define trap entry’s name, trap data type and its alias name. <Trap’s original name> is the trap
entry name, <trap type> is this trap’s data type, and <trap’s alias name> is this trap’s entry alias
name.

5. SYNTAX {<option name>,<option value>......... }

Define trap entry’s option value, if the trap has option value. <Option name> is this trap entry’s
option name; <option value> is the associated value.

6. DESCRIPTION {<description>}

<description> gives a definition of the MIB group.
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Trap Log

To turn the trap log on or off, or to view the log, go to System - Trap Management > Log select:
Log On, Log Off or View Log.

ik =10l
#EEO REE BA0 FHHEO
2001-05-08 17:17:42 (uia .i50.3.6.1.4.1.3.1.1 -

Enterprise Specific Trap (8) Uptime: & days, 8:38:46

2081-85-88 17:17:43 (via .iso.3.6.1.4.1.3.1.1
Enterprise Specific Trap (8) Uptime: & days, 8:38:47

2001-85-88 17:17:44 (via .iso.3.6.1.4.1.3.1.1
Enterprise Specific Trap (8) Uptime: 8 days, 8:38:48

20081-85-88 17:17:52 _is0.3.6.1.4.1.171.108.8.1
Enterprise Specific Trap (3) Uptime: 1 day, 4:15:83
-i50.3.6.1.4.1.171.11.8.2.1.1.1.1.18 = 1 -is0.3.6.1.4.1.171.11.8.2.1.1.2.1.18 = 18

2081-85-88 17:17:52 .iso.3.6.1.4.1.171.18.8.1

Enterprise Specific Trap (4) Uptime: 1 day, 4:15:83
-i50.3.6.1.4.1.171.11.8.2.1.1.1.8.8 = 1 .i50.3.6.1.4.1.171.11.8.2.1.1.2.8.8 = 18 -iso.f

4| | »

Figure150. Trap Log File

SMTP Setting Form

Use the SMTP Setting form to enable email alerts to be sent to the network administrator. Type
the SMTP server and domain name, and Port number used, choose Simple Login and provide the
account and password information if you prefer to use authentication, otherwise select None. Mail
Sender Name is the name that appears as the sender in the email summary. Supply a sender and
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receiver address, and you can option to send a CC to one other email account. Use the Mail Test
button to test if all information has been correctly entered and the system is functioning.

Use the Trap Mail Setting Form to specify the type of alert sent and how frequently mail alerts

should be sent.
Trap Mail SMTP Setting |

—SMTF Setting
SMTF Server Ismtpsewer. COMAapHY. Com
Puart |25—
Tupe: ISimpIe Login j
Sender Account I'I 1111
Sender Password I“"’“‘*’“‘“
Mail Sender Mame In:lient company netwark,
Sender Mail Address |.3|i.3nt@.:.:.mpan_|,|,cnm
M ail Receiver
Receiver Mail Address Iadmin@cnmpan}'.cum
Carbon Copy Recipient Iau:lmin‘l Ecompany. cor

Set Cloze | Mail Test

Figure 151. Trap Mail SMTP Settings Form
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Trap Mail Settings Forms

Use the IP Address tab specify the device and alarm. The Alarm Level pull-down menu has
standard alarms to choose from. Type the message that accompanies the mail alert in Alarm
Message.

The OID tab is used for proprietary or other objects used to trigger the email alert. Add and
remove items for email alerts the same as with other menus.

Trap biail Setting ==
IP Address | DI | 2larm Mail Interval |
IFP Address I
Alarm Lewel | Cold Start - |

Alarm Message I

IF Address I Alarm Lewel I Alarm Message I

1044 46.1 Cold Start Trapki=gl BHemove I

Ok I Cancel I

Figure 152. Trap Mail Setting Forms
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Alarm Mail Interval

Use the Alarm Mail Interval menu tab to specify the frequency with which email alarms are sent.
Alarm mail intervals may be specified using the Alarm Interval to specify the number of minutes
between emails, or use the Alarm Time to specify times when emails are sent daily. Alarm mail
intervals can be set up using both definitions if desired. Alarm Time asks you to specify the hour
(HH) and minute (MM) using 24-hour military time.

Trap kadl Setting xl
IP &ddress I alb Alarm b ail Interval I

—Alarm | ntereal
v Alarm Interval

Send trap mail every O minctes

—alarm Tirme

v Alarm Time

HH el B
Send trap mail at I 0 I daily
Hour I kA inLte |

14 oo RHemowve I

(E] I Cancel I

Figure 153. Alarm Mail Interval
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Example: Receiving alarm/trap messages by e-mail

Step 1: Set the SMTP settings

=10l %]

System View Edit MIE: Tools Accownt Winiow Help

Discaver | User Defing |
Al Basie
oz ]|
Repolling Configusation
Commmity String Contiznre

Sawve To Databsse
Cleas Databise

Trap Editor
Clear
Sort By »

Trap Type Properties
Trap View Filter Setting

Trap Mail Setting

Messages | Traps |

Figure 154.

Step 2: After setting the settings you can use “Mail Test” to test whether the settings are
correct.
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Trap Mail SMTP Setting x|

—SMTP Setting
SkTP Server Ismtpsewer.cumapny.mm
Puort IEE—
Type: ISimpIe Login j
Sender Account I‘I 11111
Sender Pazsword I****“**“
bail Sender Mame Iu:lient Company netwark,

Sender Maill Addresz Iclient@cﬂmpany_cﬂm

—hd aill Feceiver

Receiver Mail &ddress Iadmin@cnmpany.u:nm

Carbon Copy Recipient Iadmirﬂ @eompany. car

Set Cloze | kil Test

Figure 155.
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JS[=1FS)

Svsten ¥iew Edit MIB: Tools Accownt Window Help

Discover | Usger Define |
A1 Bazic Information
| & | i | i | gy |

Repolling Configuration =
Commmunity & tring Configure
Save To Datahaze
Clear Database

Trap Editor

Clear

Sort By 4

Trap Twpe Properties
Trap View Filter Setting

Log L

Trap bail SMTF Setting:

Meszages |Traps I

Figure 156.
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Step 4: Set alarm time, alarm interval and conditions for sending trap mail.

Ik G ] thiv
IP Address | 0ID | Alarm Mail Interval |

IF Address I

Alarm Lewel | Cold Stant =1

Alarm Mezzage I

IF &ddrezs I Alarm Lewel I Slarm Meszage I

1044 671 Cold Start Cald Remowe I

Ok I Cancel I

Figure 157.
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Figure 158.
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Figure 159.
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Adding Plug-In Utilities

You can develop execution files to plug into the D-View platform

How to install self-developed device SNMP module:

SNMP Module execution files must have four parameters:

/NdeviceModuleName /IIPAddress /RreadCommunityString
/WwriteCommunity String

“/N,” “/1,””/R,”” /W” respectively stand for Module Name, IP Address, Write Community
String, Read Community String.

Re-install Windows Registry and set up as follows:

Execute Regedit.

Run 21 x|

E Type the name of a program, folder, document, ar

Internet resource, and Windows will open it For you,

Qpen: Iregedit| j

I I Zancel | Browse, ., |

Figure 160.
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Under HKEY_LOCAL_MACHINE-> SOFTWARE->D-Link->Modules there are four data
folders. Enter data into these four data folders as below:

1. ExePath: Record SNMP Device Module execution file with Device OID as Key.
Select and then right-click with mouse on newly added words value. At the value
name input Device OID. Input execution file name. Add /N before the execution

file name.
&7 Registry Editor I [m] 5
Registry Edit  Wiew Faworites Help
{20 SOFTWARE | [ hame Type | Data
- ACD Systems (Default) REG_SZ (value not set)
1.3.6.1.4.1,171,10.23.2.1 REG_5Z CProgram FilesD-LinkiD-View | ModulesiDiG5-3208DaG.
1.3.6.1.4.1.171.10.24,1.1 REG_5Z CiPragram Files\D-LinkiD-Yiew\Madules\DES-3225G1D,
1.53.6.1.4.1.171.10.25.2.1 REG_5Z Z:\Program Files\D-Link\D-Yiew\Modules\DES-36240E.
1.3.6.1.4.1.171,10.28.2.1 REG_SZ Z\Program Files\ D-Link\D-Yiew Modulesi DES-6000YDE .
1.3.6,1.4.1.171.10.36.1.11 REG_SZ C\Program Files\D-LinkiD-YiewiModulesiDES-32261DE,
1.3.6.1.4.1.410.1.1.2.1.0 REG_52 C\Program Files\D-Link\D-View\ModulesWirelessaPw
=23 D-Link
{2 D-Link Mib Browser
- D-Link Mib Compiler
-] Dviews. 1
- D-Views. 1
E|{:| Modules |
-1 Installedoptions
-0 INTEL
-1 Kodak
- Logitech -
[ i L |
|My ComputeriHKEY _LOCAL_MACHINEYSOFTWARE!D-LinkiModules\ExePath 4

Figure 161.
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Editstring 2| x|

Yalue name:
|1.3.5.1.4.1.1?1.1&23.2.1

Walue data:

rogram FilesD-Link\D -View\Modules\DGES-3208N0E 53208 /MNDIGS 3208

Q. I Cancel

Figure 162.
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2. HelpPath: Record Help file location using Device OID as Key. Select and right
click to added words value. At name value input Device OID. Under data value
input Help file location and full path name.

Registry Editor ;lﬂlél

Reqistry  Edit  Wiew FEavorites Help

{1 SOFTWARE ] [ name Typs | Data

B (] ACD Systems (Default) REG_SZ (walue nat set)

{0 Adobe 1.3.6.1.4.1.171.10.23.2.1 REG_SZ C:\Program Files\D-LinkiD-viewModulesi DiaS-32084DG.

0 akis [38]1,2.6.1.4.1.171.10,24.1.1 REG_SZ C:\Pragram Files|D-Link\D-Yiew|Modules\DES- 325G\,

g 232'3'; e BE]1.3.6.14.1.171.1025.2.1 REG_57 C:\Pragram Files\D-LinkiD-View|Madules\DES- 3624|DE,

{21 Borland 1.3.6.1.4.1.1?1.10.28.2.1 REG_SZ Ci\Program Files\D-LinkiD-YiewiMadules\DES-6000YDE.
1.3.6.1.4.1.171,10,36.1.11 REG_5Z C:\Program Files|D-LinkiD-Yiew|Modules\DES-32261DE.

D Canan

22 Classes 1.3.6.1.4.1.410.1.1.2.1.0 REG_5Z Ct\Program Files\D-LinkiD-viewiModulesywirelessaPla,
21 Clients

D Compaqg

D Compadq Computer Corporatian
- Corel

=3 b-Link

{1 D-Link Mib Browser

{27 D-Link Mib Compiler

-1 Installedoptions
B-{0 INTEL
E
£

SMMP SOLUTIONS

-7 Kodak

7- Logitech -
o [»[ [ |

|My ComputeriHKEY _LOCAL_MACHINE\SOFT'WARE\D-LinkiMadulesiHelpPath

a=

Figure 163.
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Editstring 2| x|

Walue name:
|1.3.5.1.4.1.1.'-"1.1D.23.2.1

Walue data:

C:\Program Files\D-LinkAD-View i ModuleshDGS-320840 53208 hip

. I Cancel

Figure 164.

3. lcon Path: Record the position of icons used using the Device OID as Key. Select
and right click on mouse on newly added words value. Under name value input
Device OID. Under data value input Icon file location and full path name.

Note: Piease make sure you have both the .ico file and the .bmp file of the same
picture. For example, you must have dgs3208.ico and dgs3208.bmp.
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Registry Editor =10l =|
Reqistry Edit  View Favorites Help
(1 SOFTWARE | [ Mame Type | Data

-] ACD Systems (DeFauIt) REG_SZ {value not set)

{13 Adabe 1.3.6,1.4.1,171.10.23.2.1 REG_SZ C:\Program Files\D-LinkiD-Yiew\Madules| DES-32081 Mo,

(20 Aliris . 1.3.6.1.4.1.171.10.24.1.1 REG_SZ C\Program FilesiD-LinkiD-ViewiModules\DES-3225G M,
(1 Analog Devices 1.5.6.1.4.1.171.10.25.2.1 REG_5Z C:\Program FlesD-LinkiD-Yiew|Modules\DES-36241Ma.
1.3.6,1.4.1,171.10.25.2.1 REG_SZ Ci\Pragram FilesiD-LinkiD-YiewiModules\DES-60001Ma,

1.3.6.1.4.1.171.10.36.1.11 REG_SZ C\Program FilesiD-LinkiD-YiewiModules\DES-32261 Mo,

1.3.6.1.4.1.410.1.1.2.1.0 REG_SZ Ci\Program Files\D-Link\D-Yiewi Madules' WirelessaPi M,

=13 DeLink

B3 D-Link Mib Browser
{13 D-Link Mib Compiler
[ D¥iews.1

{1 D-views.1

-1 Modules

1] ExePath

-1 HelpPath

S FlconPath

-2 Madulelnfo

: D SHMP SOLUTIONS
-] InstalledOptions
B+ INTEL
E
[

]--D Kodak

7 Logitech -
4] | 4 |

|My ComputeriHKEY _LOCal_MACHIMEYSCOFTW ARED-LinkiModules! IconPath

N

Figure 165.
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Walue name:

|1.3.E.'|.4.1.1?1.1D.23.E.1

Walue data;

agram FilezhD-LinkAD-View M odules\D G5 -3208%Modulel con'dgs 32

OF.

Figure 166.

4. Module Info: Record utility related information with OID of Device as Key. Select

and right-click on mouse for newly added words value.

Under name value input

Device OID. Under data value there are four values separated by commas: Device
Role, Module Name, Home page, Company Name.
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Registry Editor ;'Elﬂ

Reqistry Edit  View Favaorites Help

{1 SOFTWARE =] [ mame Type | Data

-0 ACD Systems (Default) REG_5Z (value not set)

{0 Adobe 1.3.6.1.4.1.1?1.10.23.2.1 REG_SZ Switch; DES3208; v, DLink, com. e D-Link;

0 Aeiris [28]1,3.6.1.4.1.171.10.24.1.1 REG_SZ Switch; DES3225Genws, DLink, com, b D-Link;

1.3.6.1.4.1.1?1.10.25.2.1 REG_SZ Switch; DES3624; wiw DLink, com . b D-Link;

1.3.6.1.4.1.1?1.10.28.2.1 REG_SZ Switch; DESE000; wiwwe  DLink, com . bw; D-Link;

'D c 1.3.6.1.4.1.1?1.10.36.1.11 REG_S52 Switch; DES3226; wwww DLink, com b D-Link;
anon .

2 Classes 1.3.6.1.4.1.410.1.1.2.1.0 REG_SZ Switch; AP v DLink. com. b D-Link;

-] Corel
E-{ D-Link
{271 D-Link Mib Browser

SHMP SOLUTIONS
7-{_1 InstalledOptions
-0 INTEL

77 Kodak

]--D Logitech —
[« I3 [ K |

|My Computeri\HKEY _LOCAL_MACHIMNE, SOFTWAREYD-Link\ModulesiModuleInfo

a L=

Figure 167.
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Editsring 2| x|

Walue name:

|1.3.E.1.4.1.1?1.1D.23.2.1

Walue data:

Switch:DGS 320800 DLink. comn.ba:D -Link;

k. I Cancel

Figure 168.

Install common tools and plug-in to menu item.

Step 1: Type /DLINK_INSTALL_PATH?Conf/Resources/NewMenu.ini. For example,
install DIAP2 pathway under Tools Menu.
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: =10l x|
WEE REE B0 HAWD
[PIPAZ] =
ApplicationHame=DIAP .exe
ApplicationPath=C:\Program Files\D-LinkiD-View\5.1\Bin
Parameters=
d

Figure 169.
Application Name: execution file name
Application Path: execution file pathway

Parameters: Execution file parameters
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Step2: execution outcome

=10l x|
=181 ]
MIB Tools  *
DIAP
TFTP Server H
BlOOTP' SHMP SHMP SHMF SHMP
Ethernet PING % % ‘ % :
CompanyGroup TELNET 1011195 1011195 DEOEERER 1015132 100673133 10
General E——
Ela M arconi
LB 1011152
10.1.1.195
10.1.1.196
101011120 K3 [NEN | ]

Meszages I Traps |

Figure 170.
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Account

Account is a simple account management system to keep track of the bills. It has the following
new features:

e Each client is assigned an account with personal authorization IP Address. Each IP
Address will link to one Device Port. The system can verify and track devices in this
manner.

e Setting statement schedule allows flexibility. Different groups of clients can generate
statements at difference schedules.

e Detects abnormal usage for clients

e Assigns custom taxes to service charges (weekly, monthly, every three months, biannually,
annually)

e Credit adjust function allows you to insert credit records manually and give credit for
wrong or misdialed work.

e Late fee assessment function allows you to assign late payment charges with fixed charge
or a percentage of late pay amount.

e Real-time reporting, including current client summary, credit limit status report, payment
report, and the like.
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Figure 171.

The Account system can bundle customer equipment just like the telephone system. As with
telephone numbers, you can manage customers by means of equipment management.
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The menus available are the following:
e Client Update
¢ Client Record Query
e Client Online Query
¢ Client Abnormal Situation
e Device Utilization

e Pay Rate Configuration

Create a client entry

Create

a Entry

& Client

Open

Bind Port

Base Information Pay Fate & End Tine

Figure 172. Creating a Client Entry
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In the previous figure we establish a new customer entry by setting up the basic information. We
charge users a service charge, place time limits on usage, and create an IP Address that
corresponds to a specific port in a device. Thus customer data is established.

Client Update

Use the client update menu to view basic client information including Name, Phone, IP Address,
Switch IP Address, Switch Port used, Status, Pay and E-Mail address. To add a new client, click
the Add button to bring up the Client Manager menu (see below). Update or change existing client
information by highlighting the client on the table and clicking the Modify button. Use the Query
button to locate client records form the database.
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fﬁi‘ Client Update o [ m]

Client Marme | Client Phane | Client Address | Client IP Address | 5w

\‘\% Freeze Client
@? Unfreeze Cliernt
415 Pay Check
Ports Check
Hl Client Status

‘ Close(C]

4| | 1

Add [4) | Delete (D) Edit (E] |

Client Hame I

| | Y.

Figure 173. Client Update

Use the Freeze Client and Unfreeze Client buttons to disable (Freeze) or enable (Unfreeze) a frozen
port linked to the selected client. The Pay Check button is used to view the client’s payment
status. The Port Check button is used to detect the port number and status of the client and
update the device records from the database. The Client Status button is used to check a client’s
expiration status or to change client payment terms and expiration deadline.
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Client Manager

The Client Manager “Add” is identical to the “Modify” menu.

gﬁ Client Manager : Add Client Enkry X
Client Mame” ILuu:iu:uus Industries LLC Llignt P Address™ I'I BB . I'I g, |45 . |2E
Client Phone | |2UE ].|5553E3E Pay Type"ISi:-: b anth j

Cliert Address I'l 212 Mockingbird Ave. Clydeston MY 10174 | W 0K
Client E -t ail Ifgrunde@luciuus.cum x Cancel

Switch IP* [10.44 73 38 =] Swich Port NN = | o [ves =

[Phone number must be 0 ko 2

Figure 174.
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How to Manage a Client

Start

Chuak Pay 7

fin yes

Drizable its link port

Dizahble its bils port Enable its link port and aotice clisd

Enable its link port

N
NG

Figure 175.

When we begin to manage a client we need to determine first whether the client has paid for
services or whether it is past due. If payment is past due we close the connection (disable its link
port) and prevent the client from being connected to the network. We also need to decide whether
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the client is experiencing abnormal usage. Depending on the situation, we may disable the
client’s link port and notify the client so as to not jeopardize other clients.

Client Record Query

Locate and view client records using various search conditions including device IP address, link
port, client name and client pay status. Define the parameters and click the Query button to view
the record search results in the record table.

gf"" Client Record Query — ol =]
General I
Switch IP [0 | Switch Por [0 =1
Client Mame I FPay Statusz I.t'—‘l.ll LI
Client 1P | N | Al to | N A .| I
——————————————————| & CloselC)
Clignt Marme Client Phone Client Address | Client IP Address Switch IP Address | Switch Pork P
g | 3
A

Figure 176. Client Online Record Query
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Client Online Query

View client users currently connected to a selected device.

fﬁ"i Client Online Query - |EI|5|

071,194 <
10.15.1.65 =
10,42.73.221
101679126 ) Ouer |
101673128 <o tuenll]
10.506.24
1016.79.36
10.4473188
10.9.68.31
10,44, 75240
101679133
101.1.152
1011165
10.3711.78
10.447317 hd

Mo, | Client Mame | Client IPAddress | Client Status

Device © 15 | 4

Figure 177. Client Online Query Information
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Client Abnormal Situation

Use this to check client usage and logs of abnormal situations for a chosen device.

£% Client Abnormal Situation ] |
Client Mame | Switch IP Address | Sitch Port | Team I Group N
TMow
20027415
F<F 05:41:32
—Update Time :
20027410
F2F 12:21:28
@ Configuration
@ Update
4| | i
Start Time “rear |2|:||:|2 vI konth |-| ;I Crap |-| ;I
End Tirne ear |2EID2 ...I b anth |-| LI Dray |-| LI
Query[d] | [Deletell] | [Delete All[d] |
|sbnarmal Events : 0 [ [ L

Figure 178. Client Abnormal Situation
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Device Utilization

Analyze network usage and query total number of ports and ports open for a device.

£® Device Utilization -0l =]
Group Mame | Sum of ports | Sum of opened ports | FPercent of open... |
D-Group 94 1] 0%

‘ Claze(C) |

Figure 179. Device Utilization
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Device Group Manager

Grouping Devices

Add 1 Inzert
:: Team i
Group L
\/\ */\ Devices
Delete Remave

Figure 180.

Use the Group Manager to group devices according to purpose, location, team etc. Select devices
from the tree and drag them to another group. Add or Delete groups and teams with the buttons
on the bottom of the menu.
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gﬂ Group Manager

ER T Kt In B Kn T
"]

[t it K T n i

-|n-|r~ﬂn-|f-|\ﬁ

Switch Mame | Switch Type | Switch IP Addresz | Team
101.1.194 DES32250G 101.1.194 unzelected
10.15.1.66 DESEO0N 10.15.1.66 unzelected
104273221 DES3326 10.42.73.221 unzelected
1016.79.126 DES3226 1016.79.126 Team Sub-group
1016.73.128 DES3226 10.16.79.128 Team Sub-group
10.60.8.24 DES3326 10.60.8.24 Team Sub-group
10.16.79.36 DES3326 10.16.79.36 Team Sub-group
104473188 DES32250G 10.44.73.138 Team Sub-group
10.9.68.31 DES32250G 10.9.68.31 Team Sub-group
10.44.73.240 DES3624 10.44.73.240

Team Sub-group & I
3

BN

ARERERN

El_] bl anager
=] D-Group

Team Sub-group

1016.79.126
1016.73.128
10.50.8.24
10.16.79.36
10.44.73.188
109683
10.44.73.240
10.16.73.133

|| Add Group | [Melete Gru:uupl

Sdd Team

[Melete Treanm |

=101 %]

ﬁ]? FemoveR]

Partz Check

B Close(C) |

|Gr|:|up i1

|Team i1

|Devi|:e 15

Figure 181. Device Group Manager
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Pay Rate Configuration

To Add, Modify or Delete pay rate categories, type or select information in the spaces provided at
the bottom of the menu.

fﬁ Paxy Rate Configuration - | O | El
Mo. | M ame I Coztdollarz] | Type I Time[dayz] |
1 One week 100 One 'week n
2 e Manth 300 Qe Month n
3 Three Manth a00 Three Maonth n
4 Six Manth 1200 Six Manth 1]
Une Y'ear 2o | Dneear I
Eﬂ:l Add[i]
S Modif()
£ Delete(D)
B Close(C)

M arne IDnE ear Type IEIne ear j
Cost |2|:||:||:| Time |EI

| I 4
Figure 182. Pay Rate Configuration
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TROUBLESHOOTING

e Problem: Can’t open D-View with database error.

e Solution: Please install Access 2000.

e Problem: Can'’t find any SNMP devices in D-View.

e Solution: Please check the SNMP read community string.

£% Community String Config

Read Commurity String Ipub“,:

Cancel | |

Wike Cormmunity Sking iprivate

Figure 183.
e Problem: Can’t use MIB Utilities to manage the device in D-View

e Solution: Please check the write community string and read community string
in the device and check if this device supports MIBs.
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£% Device Properties Form Ol =]
Device Informatior
Device Name: TTRERIES P Address: |1 0.15.1.66
Fiead Comm; Ipul:nlin:: “write Comm: Iprivate
Madule Type: |DESE000 Type |
~MIE Database
[~ BRIDGE-MIE [T ENTITY-MIE —
[T IAMAIType-MIE [~ IF-MIB
[~ IGMP-5TD-MIE [T PERIDGE-MIE ||
[T Q-ERIDGE-MIB [T RFC1155-5HI
[T RFC-1212 [T RFC1213MIE ;I
ak. Caticel

Figure 184.
e Problem: Can’t send trap mail.

e Solution: Check the Trap Mail SMTP Settings (SMTP Server, Port, Type, etc.)
and Trap Mail Interval Settings (IP Address, Alarm Level, Alarm Message)
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Trap Mail SM TP SBetting

—SHTP Setting

SMTP Server I

Fort |25

Tvpe: I Simple Login ;I
Sender Account I
Sender Faszword I

b ail Sender Mame

IName

Sender Mail Address I

M ail Receiver

Feceiver b ail Addres= I

Carbon Copy Recipient I

Cloze b ail Test

Figure 185.
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Trap Madl Setting

Figure 186.
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e Problem: Auto-discover can’t find the device you want.

e Solution: Use the Discover function (under System) to find the device you want.

From IP Address IW IE I? IW
To IP &ddreszs IW-IE-I?-IW

SHMP Read Ipub",:

TirmeOut |-| ooo
(1000......10000) mest

Search Approach & LUnicast € Broadcast |

_1O x|

Samples

Dizcower Schema &= SHMPE & ICMP

Search
= Al Agents

= Select Device

Enterprizell I

Mo, | IP address

| Syztemn Description

Stop

Sawve & Exit

E =it

Figure 187.
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Problem: Can’t inset a device into the D-View 5.1 platform manually.

Solution: To insert a device into D-View 5.1 manually, right-click on tree view
or list view in the D-View Platform with the mouse to bring up the pop-up menu.
Select “Add Device” then shows the “new device form.” Input parameters and
click the ok button.

Problem: Can’t import the new device module into D-View 5.1.

Solution: You can install the device module from the D-View 5.1 CD-Rom. If
you want to upgrade the device module, you can download the latest Module
Setup file from the D-Link web site http:/www.dlink.com.

Problem: Can'’t find wireless AP module in D-View 5.1

Solution: You can’t find wireless AP because the wireless AP does not support
standard MIB (RFC1213), thus D-View 5.1 can’t find it. You can only insert it
manually.
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MENU/COMMAND QUICK REFERENCE

System View Edit MIBs Tools Account Window
Discover Topology View Device SNMP Device Configuration MIB tools Client Update Cascade
Properties MIB Browser,
Basic Information Copy MIB Il (read-only menus) MIB Compiler Client Record Query Tile
Tree View Delete Information,
Repolling Configuration IF Table, DIAP Client Online Query Minimize
Domain IF Counters,
Community String List View New IP Counters, Client Unusual
Configuration SubDomain IP Routing, TFTP Server Situations
New Device IP Address Table, ICMP
Save to Database MessagesTraps View Copy Counters, UDP Counters, Device Utilization
Paste SNMP Counters BootP
Trap Management Background Color Delete Bridge 802.1d Device Group
Trap Editor Information, (Tools ) Rate
Trap Mail SMTP New Port Table Ping Configuration,
Settings Topology Spanning Tree Detect Device Ports
Information,
Find Object Port Table Telnet

Transparent Bridge
Forwarding Table, Static
Table,

Port Counters

RMON

Statistics, History,
Alarm/Event

802.1P

Basic Configuration, Priority
Information, Port
Capability, GMRP, GARP
802.1Q

(802.1Q Bridge ) Basic
Configuration,

Ports Information, General
Information, Learning
Constraint Information
802.1Q VLAN,
Forwarding/Filtering,
Unicast//Multicast, Static
Filtering

Traffic statistics

Port VLAN Statistics
Information, High Capacity
Port, VLAN Statistics
Information

Layer 3 Utilities

IP Forwarding, RIP 2, OSPF
- (OSPF pop-up menus)
IP mroute, DVMRP

SNMP V3
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Registration Card

Print, type or use block letters.
Your name: Mr./Ms

Organization: Dept.

Your title at organization:

Telephone: Fax:

Organization's full address:

Country:

Date of purchase (Month/Day/Year):

Product Model Product Serial * Product installed in type of * Product installed in
No. computer (e.g., Compaq 486) computer serial No.

(* Applies to adapters only)

Product was purchased from:
Reseller's name:

Telephone: Fax:

Reseller's full address:

Answers to the following questions help us to support your product:
1. Where and how will the product primarily be used?
OHome OOffice OTravel OCompany Business O0Home Business OPersonal Use

2. How many employees work at installation site?
01 employee 02-9 0010-49 0050-99 00100-499 00500-999 001000 or more

3. What network protocol(s) does your organization use ?
OXNS/IPX OTCP/IP ODECnet OOthers

4. What network operating system(s) does your organization use ?

OD-Link LANsmart ONovell NetWare ONetWare Lite OSCO Unix/Xenix OPC NFS O3Com 3+Open
OBanyan Vines ODECnet Pathwork OWindows NT OWindows NTAS OWindows '95

OOthers

5. What network management program does your organization use ?
OD-View OHP OpenView/Windows OOHP OpenView/Unix OSunNet Manager OONovell NMS
ONetView 6000 OOthers,

6. What network medium/media does your organization use ?
OFiber-optics OThick coax Ethernet OThin coax Ethernet O10BASE-T UTP/STP
O0100BASE-TX O0100BASE-T4 O0100VGAnyLAN OOthers

7. What applications are used on your network?
ODesktop publishing OSpreadsheet OWord processing OCAD/CAM
ODatabase management OAccounting OOthers

8. What category best describes your company?

OAerospace OEngineering OEducation OFinance OHospital OLegal Oinsurance/Real Estate OManufacturing
ORetail/Chainstore/Wholesale OGovernment OTransportation/Utilities/Communication OVAR

OSystem house/company OOther

9. Would you recommend your D-Link product to a friend?
OYes ONo ODon't know yet

10.Your comments on this product?
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